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Safety warning notice

/\ WARNING! To reduce the possibility of heat-related injuries or of overheating the computer, do not
place the computer directly on your lap or obstruct the computer air vents. Use the computer only on a
hard, flat surface. Do not allow another hard surface, such as an adjoining optional printer, or a soft
surface, such as pillows or rugs or clothing, to block airflow. Also, do not allow the AC adapter to
contact the skin or a soft surface, such as pillows or rugs or clothing, during operation. The computer
and the AC adapter comply with the user-accessible surface temperature limits defined by the
International Standard for Safety of Information Technology Equipment (IEC 60950).
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1 Product description

Category

Description

Product name

HP EliteBook 2760p Tablet PC

Processors

Intel® 2nd Generation Core™ i7 processors (soldered to system board)

i7-2620M, 2.7-GHz (turbo up to 3.4-GHz) Dual-Core processor, 4 MB L3 cache, 35W

Intel 2nd Generation Core i5 processors (soldered to system board)

i5-2410M, 2.3-GHz (turbo up to 2.9-GHz) Dual-Core processor, 3 MB L3 cache, 35W (select
models only)

i5-2520M, 2.5-GHz (turbo up to 3.2-GHz) Dual-Core processor, 3 MB L3 cache, 35W

i5-2540M, 2.6-GHz (turbo up to 3.3-GHz) Dual-Core processor, 3-MB L3 cache

Chipset

Mobile Intel QM67 Express Chipset

Graphics

Intel HD Graphics 3000

Integrated with shared video memory

Supports dual-display ports through the dock

Panel

30.7-em (12.1-in) lllumi-Lite WXGA UWVA (1280x800) with digitizer pen and/or multi-
touch

30.7-cm (12.1-in) lllumi-Lite WXGA UWVA outdoor view (1280x800) with digitizer pen
and/or multi-touch

Chemically-strengthened glass top cover

Memory

Two customer-accessible/upgradeable memory module slots

Supports dual-channel memory

Supports up to 16 GB of PC3 10600, 1333 MHz, DDR3 system RAM (running at 1066 MHz)

Supports the following configurations:

e 16384 MB total system memory (8192 MB x 2)

e 12288 MB total system memory (8192 MB + 4096 MB)
e 8192 MB total system memory (4096 MB x 2)

e 8192 MB total system memory (8192 MB x 1)

e 6144 MB total system memory (4096 MB + 2048 MB)
e 4096 MB total system memory (2048 MB x 2)

e 4096 MB total system memory (4096 MB x 1)

e 3072 MB total system memory (2048 MB + 1024 MB)
e 2048 MB total system memory (2048 MB x 1)




Category Description

Hard drives Supports 7-mm (2.5 in) hard drives

Customer-accessible

Supports the following SATA drives:
e 500 GB, 7200 rpm hard drive
e 320 GB, 7200 rpm hard drive
e 320 GB SED, 7200 rpm hard drive
e 250 GB, 7200 rpm hard drive

Supports the following solid-state drives:

e 256GB
e 160GB
e 128GB
Audio/Visual Integrated dual-array microphone

High-definition (HD) audio with SRS premium sound

Stereo speakers (2)

720p webcam

Modem 56K V.92 MDC data/fax modem

Modem cable not included

Supports “no modem” option

Ethernet Intel 82579LM Gigabit Network Connection 10/100/1000 network interface card (NIC)
with iAMT

S3/54/55 wake on LAN

NIC power-down technology

Ethernet cable not included

Wireless Integrated wireless local area network (WLAN) options by way of the
following wireless modules:

Supports the following WLAN formats:

e  Broadcom 4313GN 802.11b/g/n 1x1 WiFi Adapter

e  Broadcom 43224 AGN 802.11a/b/g/n 2x2 WiFi Adapter
e Intel Centrino® Advanced-N 6205 802.11a/b/g/n

Supports “no WLAN" option

Two WLAN antennas built into display assembly

Integrated WWAN options by way of wireless module:

Two WWAN antennas (world-wide 5-band) built into display assembly

Supports "no WWAN" option

2 Chapter 1 Product description



Category Description

Subscriber identity module (SIM) security (customer-accessible in battery bay)

Qualcom 3000 HSPA/CDMA with GPS support (select models only), (not available in China)

Ericsson 5521 HSPA+ (Sonic)

Integrated wireless personal area network (WPAN) options by way of 2.1
Bluetooth® module:

Supports “no WPAN" option

Broadcom Bluetooth

External media card ExpressCard 34 mm

Digital Media Reader Slot, supporting the following optional formats:
e  Secure Digital (SD) Memory Card
e  MultiMediaCard (MMC)

Ports Audio-in/audio out (stereo headphone/microphone combination)

RJ-11 (modem)

RJ-45 (Ethernet, includes link and activity lights)

USB 2.0 (3), one powered/charging

VGA (Dsub 15-pin)

1394a

Multipin AC power

Docking connector

SD slot

Travel battery connector

Docking For HP 2740p Ultra-Slim Expansion Base
Keyboard Full-size keyboard
Dual point

Spill-resistant design, DuraKey coating

TouchPad supports:
e  2-way scroll
e Taps enabled as default

e  2-Finger Scrolling, 2-Finger Zoom (Pinch) gestures enabled by default

Digital eraser pen with tether

Power requirements AC adapter with localized cable plug support (3-wire plug with ground pin):

65W Smart AC adapter RC V 3W

65W Smart AC adapter RC V EM 3W
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Category

Description

65W travel AC adapter

Support for the following batteries:

6-cell, 2.0 Ah (44 Whir) Li-ion battery with fuel gauge LEDs

6-cell, 2.0 Ah (39 Whr) Li-ion Long Life battery (select models only)

Supports optional HP2700 Ultra-Slim Battery

HP Fast Charge Technology

Security

Integrated fingerprint reader

Integrated smart card reader (active) Alcor AU9540

Supports security lock

Trusted platform module (TPM) V.1.2

Preboot authentication (password, smart card)

HP ProtectTools

HP Power Assistant

Operating system

Preinstalled:

Windows 7 Professional 64 (U.S., Canada, and Japan only)

Windows 7 Professional 32 (U.S., Canada, and Japan only)

Windows 7 Home Premium 64 (U.S., Canada, and Japan only)

Windows 7 Home Premium 32 (U.S., Canada, and Japan only)

FreeDOS

Preinstalled with Microsoft® Office:

Windows 7 Professional 32 or 64 with Microsoft® Office 2010 Personal (Japan only)

Windows 7 Professional 32 or 64 with Microsoft Office 2010 Professional (Japan only)

Windows 7 Professional 32 or 64 with Microsoft Office 2010 Home and Business (Japan
only)

Windows 7 Professional 32 or 64 with Microsoft Office 2010 Starter (excludes Japan)

Windows 7 Home Premium 32 or 64 with Microsoft Office 2010 Personal (Japan only)

Windows 7 Home Premium 32 or 64 with Microsoft Office 2010 Professional (Japan only)

Windows 7 Home Premium 32 or 64 with Microsoft Office 2010 Home and Business (Japan
only)

Windows 7 Home Premium 32 or 64 with Microsoft Office 2010 Starter (excludes Japan)

Restore Media:

Windows 7 Professional 32 or 64

Windows 7 Home Premium 32 or 64

Chapter 1
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Category Description

DRDVD Windows 7

Web-only support:

Windows XP Professional 32

Windows XP Tablet Edition

Windows Vista Business 32 or 64

Windows Vista Enterprise 32 or 64

Windows 7 Enterprise 32 or 64

Windows 7 Ultimate 32 or 64

Certified:

Microsoft WHQL

Novell

SuSE Linux

Serviceability End-user replaceable parts:

AC adapter

Battery

Hard drive

Memory module

WILAN module

WWAN module
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2 External component identification

Top

TouchPad

Component Description

1 Pointing stick Moves the pointer and selects or activates items on the
screen.

(2) Left pointing stick button Functions like the left button on an external mouse.

3) TouchPad Moves the pointer and selects or activates items on the
screen.

(4) Left TouchPad button Functions like the left button on an external mouse.

(5) Right pointing stick button Functions like the right button on an external mouse.

(6) Right TouchPad button Functions like the right button on an external mouse.

Chapter 2 External component identification



Lights

O®&

Component Description
1) Caps lock light On: Caps lock is on.
(2) TouchPad light e  Off: TouchPad is on.
e  Amber: TouchPad is off.
(3) Mute light e  White: Computer sound is on.

L[

e  Amber: Computer sound is off.

(4) Volume down light White: The computer volume is being decreased.

(5) Volume up light White: The computer volume is being increased.

(6) Num lock light On: Num lock is on and the embedded numeric keypad is
enabled.

(7) ﬂ Drive light e White: The hard drive or optical drive is being accessed.

e  Amber: HP 3D DriveGuard has temporarily parked the
hard drive.

Top



8

Component

Description

(8) Battery light

White: A battery is close to full charge capacity.

Amber: A battery that is the only available power source
has reached a low battery level. When the battery
reaches a critical battery level, the battery light begins
blinking rapidly.

Off: If the computer is plugged into an external power
source, the light turns off when all batteries in the
computer are fully charged. If the computer is not
plugged into an external power source, the light stays off
until the battery reaches a low battery level.

9) (!J Power light

On: The computer is on.
Blinking: The computer is in the Sleep state.

Off: The computer is off or in Hibernation.

Chapter 2 External component identification



Buttons

Component

Description

M 40

Volume mute button

Mutes and restores speaker sound.

(2)

Volume down button

Decreases computer volume.

(3)

Volume up button

Increases computer volume.

Top



Keys

Component Description

1) esc key Displays system information when pressed in combination
with the fn key.

(2) fn key Executes frequently used system functions when pressed in
combination with a function key, the num Ik key, or the esc
key.

(3) .-'E. Windows logo key Displays the Windows Start menu.

o

@ = Windows applications key Displays a shortcut menu for items beneath the pointer.

(5) Embedded numeric keypad keys Can be used like the keys on an external numeric keypad
when the embedded numeric keypad is turned on.

6) Function keys Execute frequently used system functions when pressed in

combination with the fn key.

10 Chapter 2 External component identification



Front

Y
©

Component

Description

1)) Webcam light

On: The webcam is in use.

(2) External WWAN antenna button

Opens the external wireless wide area network (WWAN)
antenna.

(3) External WWAN antenna

Send and receive wireless signals to communicate with wireless
wide-area networks (WWAN).

(4) Power switch

When the computer is off, slide the switch to the right fo turn
on the computer.

When the computer is on, slide the switch to the right to shut
down the computer.

When the computer is in the Sleep state, slide the switch to
the right briefly to exit Sleep.

When the computer is in Hibernation, slide the switch to the
right briefly to exit Hibernation.

If the computer has stopped responding and Windows shutdown
procedures are ineffective, slide the switch fo the right and hold
for at least 5 seconds to turn off the computer.

To learn more about your power settings, select Start > Control

Panel > System and Security > Power Options.

(5) Speakers (2)

Produce sound.

(6) Display release latch

Opens the computer.

(7) Bluetooth® compartment

Contains an optional Bluetooth device.

Front
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Right

Component

Description

m

Fingerprint reader (select models only)

Allows a fingerprint logon to Windows instead of a
password logon.

(2)

QuickWeb button

e When the computer is off or in Hibernation, press the
button to open HP QuickWeb.

e When the computer is in Microsoft Windows, press the
button to open the default Web browser.

e  When the computer is in HP QuickWeb, press the
button to open the default Web browser.

NOTE: For more information, refer to “HP QuickWeb” in
this guide and to the HP QuickWeb software Help. If your
computer does not have HP QuickWeb software, the button
does not perform any action or function.

3)

‘:} Audio-out (headphone) jack/Audio-in

(microphone) jack

Connects optional powered stereo speakers, headphones,
earbuds, a headset, or television audio. Also connects an
optional headset microphone.

WARNING! To reduce the risk of personal injury, adjust
the volume before putting on headphones, earbuds, or a
headset. For additional safety information, refer to the
Regulatory, Safety, and Environmental Notices.

NOTE: When a device is connected fo the jack, the
computer speakers are disabled.

NOTE: A 4-conductor audio plug headphone with
microphone is needed in order to use the microphone
function.

4

Smart card reader

Supports optional smart cards and Java™ Cards.

(5)

USB 2.0 ports (2)

Connect optional USB devices.

12 Chapter 2
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Left

Component

Description

(6) RJ-11 (modem) jack (select models only) Connects a modem cable.

(7) E Security cable slot Attaches an optional security cable to the computer.
NOTE: The security cable is designed to act as a
deferrent, but it may not prevent the computer from being
mishandled or stolen.

Component Description

(1) Media Card Reader Supports the following digital card formats:

e  MultiMediaCard
e  Secure Digital (SD) Card

(2) Pen holder Stores the digitizer pen.

(3) Vent Enables airflow to cool internal components.

NOTE: The computer fan starts up automatically o cool
internal components and prevent overheating. It is normal for
the internal fan to cycle on and off during routine operation.

4) ExpressCard slot (select models only) Supports optional ExpressCards.

(5) tg3) Wireless light e  White: An integrated wireless device, such as a

I wireless local area network (WLAN) device, the HP
Mobile Broadband Module, and/or a Bluetooth device,
is on.
e  Amber: All wireless devices are off.
(6) Wireless switch Turns the wireless feature on or off, but does not create a

wireless connection.

NOTE: A wireless network must be set up in order to
establish a wireless connection.

Left
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Component Description

(7) 1394 port Connects an optional IEEE 1394 or 1394a device, such as
a camcorder.

(8) USB charging port Provides power to a USB device, such as an optional

external MultiBay, if used with a powered USB cable.

Display

Component Description

1) WWAN antennas (2)* (select models only) Send and receive wireless signals to communicate with wireless
wide-area networks (WWAN).

(2) WILAN antennas (2)* Send and receive wireless signals to communicate with wireless
local area networks (WLAN).

(3) Webcam light On: The webcam is in use.

(4) Webcam Records video and captures still photographs.
To use the webcam, select Start > All Programs > HP >
HP Webcam.

(5) Keyboard light button Opens and turns on the keyboard light.

14 Chapter 2 External component identification



Component Description

(6) Touch screen Allows you to perform certain actions using your fingers or the
digitizer pen.
(7) Ambient light sensor Automatically adjusts the display brightness based on the lighting

conditions in your environment.

(8) Internal microphones (2) Record sound.

*The antennas are not visible from the outside of the computer. For optimal transmission, keep the areas immediately around
the antennas free from obstructions. To see wireless regulatory notices, refer to the section of the Regulatory, Safety, and
Environmental Notices that applies to your country or region. These notices are located in Help and Support.

Display

15



Rear

RS

Component Description

1) Jog dial In slate mode, functions like the enter key and the
up and down arrows on a standard keyboard.
e  Press inward to enter a command.
e Rotate up to scroll up.
e  Rotate down to scroll down.

(2) esc button In slate mode, allows you to exit or escape out of
an application.

(3) .1-'. Rotate button In slate mode, switches the image between
landscape and portrait orientation.

(4) ctrl+alt+del button* In slate mode:

e While Windows is running, press the button
with the pen to enter the ctrl+alt+del
command.*

e While the Computer Setup utility is running,
press the button with the pen to enter the
reset command. The computer resets and all
unsaved information is lost. The reset function
can be used fo restore functionality when the
system has become unresponsive.

(5) Q

Power connector

Connects an AC adapter.

@

RJ-45 (network) jack

Connects a network cable.

7 I

External monitor port

Connects an external VGA monitor or projector.

*To protect your work and the system, the ctrl+alt+delete command cannot be entered using the ctrl, alt, and del keys on the

on-screen keyboard.

16 Chapter 2 External component identification



Bottom

® @®

Component Description

(1) Battery bay Holds the battery.

(2) SIM slot Supports a wireless subscriber identity module (SIM). The
SIM slot is located inside the battery bay.

(3) Vents (3) Enable airflow to cool internal components.

NOTE: The computer fan starts up automatically to cool
internal components and prevent overheating. It is normal for
the internal fan to cycle on and off during routine operation.

@ =

Hard drive bay

Contains the hard drive, the wireless LAN module slot, the
WWAN module slot, and the memory module slot.

CAUTION: To prevent an unresponsive system, replace
the wireless module only with a wireless module authorized
for use in the computer by the governmental agency that
regulates wireless devices in your country or region. If you
replace the module and then receive a warning message,
remove the module to restore computer functionality, and
then contact technical support through Help and Support.

(5) Docking connector Connects an optional docking device.

(6) Charge level indicator Displays the approximate remaining battery charge.
(7) Battery release latch Releases the battery from the battery bay.

(8) Accessory battery connector Connects an optional accessory battery.

9) Accessory battery connector door Slides open to expose the accessory battery connector.

Bottom
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3 lllustrated parts catalog

Serial number label location

When ordering parts or requesting information, the serial number label, located inside the battery bay,
provides important information that you may need when contacting technical support.

O XK XXX
©—seriai: xocooocoood I INIEINY I
&EE%W AR AR

-

Component Description
1) Product name The product name affixed to the front of your
computer.
(2) Serial number An alphanumeric identifier that is unique to each
product.
3) Product part number The identifier that provides specific information about

the product's hardware components. The part number
helps a service technician to determine what
components and parts are needed.

(4) Warranty The duration of the warranty period for this computer.

18 Chapter 3 lllustrated parts catalog
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Item  Description Spare part

number
(1) External antenna 657835-001
(2) Display assembly (includes 2 WLAN antenna transceivers and cables and 2 WWAN antenna transceivers and
cables)
30.7 em (12.1 in) WXGA, LED, AntiGlare touch screen display 649753001
30.7 em (12.1 in) WXGA, LED, AntiGlare touch screen display for use outdoors 649754-001
(3) Hinge cover assembly (included in the Plastics Kit, spare part number 649764-001)
(4) Keyboard with TouchPad and pointing stick (includes buttons and cables)
For use in Belgium 649756-A41
For use in Brazil 649756-201
For use in Bulgaria 649756-261
For use in the Czech Republic 649756-A81
For use in Denmark 649756-081
For use in Denmark, Finland, Norway, and Sweden 649756-DH1
For use in France 649756-051
For use in French Canada 649756-121
For use in Germany 649756-041
For use in Greece 649756-D)1
For use in Hungary 649756-211
For use in Iceland 649756-DD1
For use internationally 649756-B31
For use in Israel 649756-BB1
For use in ltaly 649756-061
For use in Japan 649756-291
For use in Latin America 649756-161
For use in Northwest Africa 649756-DW1
For use in Norway 649756-091
For use in Portugal 649756-131
For use in Russia 649756-251
For use in Saudi Arabia 649756-171
For use in Slovakia 649756-A81
For use in South Korea 649756-AD1
For use in Spain 649756-071
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ltem  Description Spare part
number
For use in Sweden and Finland 649756871
For use in Switzerland 649756-BG1
For use in Taiwan 649756-AB1
For use in Thailand 649756-281
For use in Turkey 649756-141
For use in the United Kingdom 649756-031
For use in the United States 649756001
(5) Memory modules (PC3-10600, 1333-MHz, DDR3)
8-GB 634091-001
4-GB 621569-001
2-GB 621565-001
(6) Top cover assembly (includes TouchPad board, QuickWeb button, and capacitive 649768-001
board)
(7) TouchPad button board (included with the top cover assembly 649768-001)
(8) TouchPad button board bracket (included with the top cover assembly 649768-001)
(9) RTC battery 649769-001
(10)  Speaker assembly 649767-001
(11)  System board shield (includes replacement thermal material) 649760-001
(12)  Fan/heat sink assembly (includes replacement thermal material) 649759-001
(13) Security lock
(14) Modem module 56k, v.92 MDC 1.5 Guzzi F data/fax, for use in all countries 628824-001
NOTE: The modem module spare part kit does not include a modem module cable. The
modem module cable is included in the Cable Kit, spare part number 649758-001. See
Cable Kit on page 25 for more Cable Kit spare part number information.
(15) Smart card reader 597839-001
(16) System board (includes replacement thermal material)
For use in all countries and regions except Russia and the People's Republic of China:
e  Equipped with Second Generation Intel Core i5-2410M Dual-Core processor [2.3 GHz ~ 649745-001
(turbo up to 2.9 GHz), 3 MB L3 cache]
e  Equipped with Second Generation Intel Core i5-2520M Dual-Core processor [2.5 GHz ~ 649746-001
(turbo up to 3.2 GHz), 3 MB L3 cache]
e  Equipped with Second Generation Intel Core i5 2540M Dual-Core processor [2.6 GHz ~ 649747-001

(turbo up to 3.3 GHz), 3 MB L3 cache]

Computer major components
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ltem  Description Spare part
number
e  Equipped with Second Generation Intel Core i7-2620M Dual-Core processor [2.7 GHz ~ 649748-001
(turbo up to 3.4 GHz), 4 MB L3 cache]
For use only in Russia and the People's Republic of China:
e  Equipped with Second Generation Intel Core i5-2410M Dual-Core processor [2.3 GHz ~ 649749-001
(turbo up to 2.9 GHz), 3 MB L3 cache]
e Equipped with Second Generation Intel Core i5-2520M Dual-Core processor [2.5 GHz ~ 649750-001
(turbo up to 3.2 GHz), 3 MB L3 cache]
e Equipped with Second Generation Intel Core i5-2540M Dual-Core processor [2.6-GHz ~ 649751-001
(turbo up to 3.3 GHz), 3 MB L3 cache]
e Equipped with Second Generation Intel Core i7-2620M Dual-Core processor [2.7 GHz ~ 649752-001
(turbo up to 3.4 GHz), 4 MB L3 cache]
(17)  Audio connector board 649762001
(18)  Latch Kit 597837001
(19)  Bluetooth module 537921-001
NOTE: The Bluetooth module spare part kit does not include a Bluetooth module cable. The
Bluetooth module cable is included in the Cable Kit, spare part number 649758-001. See
Cable Kit on page 25 for more Cable Kit spare part number information.
(20) Bluetooth cable (included in the Cable Kit, spare part number 649758-001)
(21) QuickWeb button (included in the top cover assembly, spare part number 649768-001)
(22) Pen (includes tether) 606899-001
(23) Base enclosure (includes latch) 649757-001
WWAN modules (not illustrated)
Ericsson 5521 HSPA+ WWAN 632155-001
Qualcomm Gobi 3000 HSPA/CDMA WWAN module with GPS (not available in China) 634400-001
(24) Hard drive (includes bracket)
320 GB, 7200 rpm, SATA 7 mm (2.5 in) self-encrypting drive (SED) 656621-001
320 GB, 7200 rpm, SATA 7 mm (2.5 in) 656620-001
250 GB, 7200 rpm, SATA7 mm (2.5 in) 656619-001
128 GB solid-state drive 653017001
160 GB solid-state drive 653018-001
(25) Memory module (PC3-10600, 1333-MHz, DDR3)
8 GB 634091-001
4GB 621569-001
2 GB 621565-001

Chapter 3 lllustrated parts catalog



ltem  Description Spare part
number
1 GB 639738-001
(26) WLAN module
Broadcom 43224 802.11a/b/g/n 2x2 WiFi Adapter
e  For use in North America and Latin America 582564-001
e  For use in Europe and Asia 582564-002
Broadcom 4313GN 802.11b/g/n 1x1 WiFi Adapter 593836-001
Intel Centrino Advanced-N 6205 a/b/g/n 631954-001
(27) Li-ion battery (with charging indicator)
6-cell, 39 Whr, 2.0-Ah 454668-001
6-cell, 44 Whr, 2.0-Ah 593592001
(28) Service access cover (included in the Plastics Kit, spare part number 649764-001)

Computer major components
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Plastics Kit
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Item

Description

Spare part number

Plastics Kit

649764-001

1) VGA bracket

(2) Display hinge cover

(3) ExpressCard slot protective insert
(4) Service access cover

(5) RJ11 door
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Cable Kit

Item Description Spare part number
Cable Kit 649758001
(1) RJ-11 connector cable
(2) Bluetooth module cable
(3) Audio cable
(4) TouchPad connector cable
(5) Volume connector cable
Cable Kit
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Mass storage devices

Description Spare part number

Hard drives (includes bracket)

320 GB SED, 7200 rpm, 7 mm (2.5 in) 656621001
320 GB, 7200 rpm, 7 mm (2.5 in) 656620-001
250 GB, 7200 rpm, 7 mm (2.5 in) 656619-001
128 GB solid-state drive (SSD) 653017001
160 GB SSD 653018001
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Miscellaneous parts

Description Spare part number
AC adapter

65W AC travel adapter (for use only in Japan) 592814-001

65W Smart AC adapter, RC V, 3W 609939-001

65W Smart AC adapter, RCV, EM. 3W 609948-001

Rubber Kit (includes feet) 649765-001

HP 2740 Ultra-Slim Expansion Base 606172-001

Power cords

For use in Argentina 490371-DO1
For use in Australia 490371011
For use in Brazil 490371-202
For use in Europe, the Middle East, and Africa 490371-021
For use in India 490371-D61
For use in Israel 490371-BB1
For use in ltaly 490371061
For use in Japan 490371-291
For use in the People's Republic of China 490371-AA1
For use in South Africa 490371-AR1
For use in South Korea 490371-AD1
For use in Switzerland 490371-111
For use in Taiwan 490371-AB1
For use in Thailand 490371-201
For use in the United Kingdom and Singapore 490371031
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Description Spare part number

For use in the United States 490371-001

Screw Kit 649766-001
e  Phillips 2.5x8.0 captive screw
e  Phillips 2.0x7.0 captive screw
e  Phillips 2.0x3.0 captive screw
e  Phillips 3.0x2.5 screw

e  Phillips 2.5x3.0 screw

e  Phillips 2.5x6.0 screw

e  Phillips 2.0x4.0 screw

e  Phillips 2.0x3.5 screw

e  Phillips 2.0x3.0 screw

e  Phillips 2.0x2.0 screw

e  Phillips 1.5x1.5 Panhead screw
e  Torx 8M2.2x7.0 screw

o Torx 8M2.2x5.0 screw
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Sequential part number listing

Spare part number Description

454668-001 6-cell, 39 Whr, 2.0 Ah, Li-ion battery (with charging indicator)

490371-001 Power cord for use in North America

490371011 Power cord for use in Australia

490371021 Power cord for use in Europe, the Middle East, and Africa

490371-031 Power cord for use in the United Kingdom and Singapore

490371061 Power cord for use in ltaly

490371-111 Power cord for use in Switzerland

490371-201 Power cord for use in Thailand

490371-202 Power cord for use in Brazil

490371-291 Power cord for use in Japan

490371-AA1 Power cord for use in the People's Republic of China

490371-AB1 Power cord for use in Taiwan

490371-AD1 Power cord for use in Korea

490371-AR1 Power cord for use in South Africa

490371-BB1 Power cord for use in Israel

490371-DO1 Power cord for use in Argentina

490371-D61 Power cord for use in India

537921-001 Bluetooth module (The Bluetooth cable is included in the Cable Kit, spare part number 649758-001.)
582564-001 Broadcom 43224 802.11 a/b/g/n 2x2 WiFi Adapter: For use in Antigua and Barbuda,

Argentina, Aruba, the Bahamas, Barbados, Belize, Bermuda, Bolivia, Brazil, the British Virgin
Islands, Canada, Cayman Islands, Chile, Colombia, Costa Rica, the Dominican Republic, Ecuador,
El Salvador, French Guiana, Grenada, Guadeloupe, Guam, Guatemala, Guyana, Haiti, Honduras,
Jamaica, Martinique, Mexico, the Nether Antilles, Nicaragua, Panama, Paraguay, Peru, Puerto
Rico, St. Kitts and Nevis, St. Vincent and the Grenadines, Suriname, the United States, Uruguay,
U.S. Virgin Islands, and Venezuela

582564-002 Broadcom 43224 802.11 a/b/g/n 2x2 WiFi Adapter: For use in Albania, Algeria, Angola,
Australia, Austria, Bahrain, Bangladesh, Belarus, Belgium, Benin, Botswana, Brunei, Bulgaria,
Burkina Faso, Burundi, Cambodia, Cameroon, Cape Verde, the Central African Republic, Chad, the
People's Republic of China, the Congo, Croatia, Cyprus, the Czech Republic, Denmark, Djibouti,
Egypt, Equatorial Guineaq, Estonia, Finland, France, Gabon, Gambia, Germany, Ghana, Gibraltar,
Greece, Guinea, Guinea-Bissau, Hong Kong, Hungary, Iceland, India, Indonesia, Ireland, Israel,
ltaly, the Ivory Coast, Japan, Jordan, Kenya, Kiribati, Kuwait, Kyrgyzstan, Laos, Latvia, Lebanon,
Liberia, Liechtenstein, Lithuania, Luxembourg, Madagascar, Malaysia, Mali, Mauritania, Mauritius,
Montenegro, Morocco, Mozambique, Namibia, Nepal, the Netherlands, New Zealand, Niger,
Nigeria, Norway, Oman, Pakistan, the Philippines, Poland, Portugal, Qatar, Romania, Russia,
Rwanda, Sao Tome and Principe, Saudi Arabia, Senegal, Serbia, Sierra Leone, Singapore,
Slovakia, Slovenia, South Africa, South Korea, Spain, Sri Lanka, Switzerland, Syria, Taiwan,
Tanzania, Thailand, Togo, Tunisia, Turkey, the United Arab Emirates, the United Kingdom, Vietnam,
Yemen, and Zimbabwe
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Spare part number

Description

592814-001

65W AC travel Adapter (for use in Japan)

593592-001

6-cell, 44 Whr, 2.0 Ah, Li-ion battery (with charging indicator)

593836-001

Broadcom 4313AGN 802.11a/b/g/n 1x1 Adapter: For use in Albania, Algeria, Angola, Antigua
and Barbuda, Argentina, Aruba, Australia, Austria, the Bahamas, Bahrain, Bangladesh, Barbados,
Belarus, Belgium, Belize, Benin, Bermuda, Bolivia, Botswana, Brazil, the British Virgin Islands,
Brunei, Bulgaria, Burkina Faso, Burundi, Cambodia, Cameroon, Canada, Cape Verde, Cayman
Islands, the Central African Republic, Chad, Chile, the People's Republic of China, Colombia, the
Congo, Costa Rica, Croatia, Cyprus, the Czech Republic, Denmark, Djibouti, the Dominican
Republic, Ecuador, Egypt, El Salvador, Equatorial Guinea, Estonia, Finland, France, French Guiana,
Gabon, Gambia, Germany, Ghana, Gibraltar, Greece, Grenada, Guinea, Guadeloupe, Guam.
Guatemala, Guinea-Bissau, Guyana, Haiti, Honduras, Hong Kong, Hungary, Iceland, Indiq,
Indonesia, Ireland, Israel, ltaly, the Ivory Coast, Jamaica, Japan, Jordan, Kenya, Kiribati, Kuwait,
Kyrgyzstan, Laos, Latvia, Lebanon, Liberia, Liechtenstein, Lithuania, Luxembourg, Madagascar,
Malaysia, Mali, Martinique, Mauritania, Mauritius, Mexico, Montenegro, Morocco, Mozambique,
Namibia, Nepal, the Nether Antilles, the Netherlands, New Zealand, Nicaragua, Niger, Nigeria,
Norway, Oman, Pakistan, Panama, Paraguay, Peru, the Philippines, Poland, Portugal, Puerto Rico,
Qatar, Romania, Russia, Rwanda, Sao Tome and Principe, Saudi Arabia, Senegal, Serbia, Sierra
Leone, Singapore, Slovakia, Slovenia, South Africa, South Korea, Spain, Sri Lanka, St. Kitts and
Nevis, St. Vincent and the Grenadines, Suriname, Switzerland, Syria, Taiwan, Tanzania, Thailand,
Togo, Tunisia, Turkey, the United Arab Emirates, the United Kingdom, the United States, Uruguay,
U.S. Virgin Islands, Venezuela, Vietnam, Yemen, and Zimbabwe

597837-001

Latch Kit

597839-001

Smart card reader

606172-001

HP 2740 Ultra-Slim Expansion Base

606899-001

Pen (includes tether)

609939001

65W AC Smart Adapter, RCV, 3W

609948-001

65W AC Smart Adapter, RC V, EM 3W

621565-001

2 GB memory module (PC3-10600, 1333 MHz, DDR3, shared)

621569-001

4 GB memory module (PC3-10600, 1333 MHz, DDR3, shared)

628824-001

Modem module, 56K, v.92 MDC 1.5 Guzzi F data/fax, for use in all countries

NOTE: The modem module spare part kit does not include a modem module cable. The modem
module cable is included in the Cable Kit, spare part number 649758-001. See Cable Kit
on page 25 for more Cable Kit spare part number information.
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Spare part number

Description

631954-001

Intel Centrino Advanced-N 6205 a/b/g/n WLAN module for use in Albania, Algeria, Angola,
Antigua and Barbuda, Argentina, Aruba, Australia, Austria, the Bahamas, Bahrain, Bangladesh,
Barbados, Belarus, Belgium, Belize, Benin, Bermuda, Bolivia, Botswana, Brazil, the British Virgin
Islands, Brunei, Bulgaria, Burkina Faso, Burundi, Cambodia, Cameroon, Canada, Cape Verde,
Cayman Islands, the Central African Republic, Chad, Chile, the People's Republic of China,
Colombia, the Congo, Costa Rica, Croatia, Cyprus, the Czech Republic, Denmark, Djibouti, the
Dominican Republic, Ecuador, Egypt, El Salvador, Equatorial Guinea, Estonia, Finland, France,
French Guiana, Gabon, Gambia, Germany, Ghana, Gibraltar, Greece, Grenada, Guineq,
Guadeloupe, Guam. Guatemala, Guinea-Bissau, Guyana, Haiti, Honduras, Hong Kong, Hungary,
Iceland, India, Indonesia, Ireland, Israel, ltaly, the Ivory Coast, Jamaica, Japan, Jordan, Kenya,
Kiribati, Kuwait, Kyrgyzstan, Laos, Latvia, Lebanon, Liberia, Liechtenstein, Lithuania, Luxembourg,
Madagascar, Malaysia, Mali, Martinique, Mauritania, Mauritius, Mexico, Montenegro, Morocco,
Mozambique, Namibia, Nepal, the Nether Antilles, the Netherlands, New Zealand, Nicaragua,
Niger, Nigeria, Norway, Oman, Pakistan, Panama, Paraguay, Peru, the Philippines, Poland,
Portugal, Puerto Rico, Qatar, Romania, Russia, Rwanda, Sao Tome and Principe, Saudi Arabia,
Senegal, Serbia, Sierra Leone, Singapore, Slovakia, Slovenia, South Africa, South Korea, Spain, Sri
Lanka, St. Kitts and Nevis, St. Vincent and the Grenadines, Suriname, Switzerland, Syria, Taiwan,
Tanzania, Thailand, Togo, Turkey, the United Arab Emirates, the United Kingdom, the United States,
Uruguay, U.S. Virgin Islands, Venezuela, Vietnam, Yemen, and Zimbabwe

632155-001

Ericsson 5521 HSPA+ WWAN module for use in Albania, Algeria, Angola, Antigua and Barbuda,
Argentina, Aruba, Australia, Austria, the Bahamas, Bahrain, Bangladesh, Barbados, Belarus,
Belgium, Belize, Benin, Bermuda, Bolivia, Botswana, Brazil, the British Virgin Islands, Brunei,
Bulgaria, Burkina Faso, Burundi, Cambodia, Cameroon, Canada, Cape Verde, Cayman Islands, the
Central African Republic, Chad, Chile, the People's Republic of China, Colombia, the Congo, Costa
Rica, Croatia, Cyprus, the Czech Republic, Denmark, Djibouti, the Dominican Republic, Ecuador,
Egypt, El Salvador, Equatorial Guinea, Estonia, Finland, France, French Guiana, Gabon, Gambia,
Germany, Ghana, Gibraltar, Greece, Grenada, Guinea, Guadeloupe, Guam. Guatemala, Guinea-
Bissau, Guyana, Haiti, Honduras, Hong Kong, Hungary, Iceland, India, Indonesia, Ireland, Israel,
ltaly, the Ivory Coast, Jamaica, Japan, Jordan, Kazakhstan, Kenya, Kiribati, Kuwait, Kyrgyzstan,
Laos, Latvia, Lebanon, Liberia, Liechtenstein, Lithuania, Luxembourg, Madagascar, Malaysia, Mali,
Martinique, Mauritania, Mauritius, Mexico, Montenegro, Morocco, Mozambique, Namibia, Nepal,
the Nether Antilles, the Netherlands, New Zealand, Nicaragua, Niger, Nigeria, Norway, Oman,
Pakistan, Panama, Paraguay, Peru, the Philippines, Poland, Portugal, Puerto Rico, Qatar, Romania,
Russia, Rwanda, Sao Tome and Principe, Saudi Arabia, Senegal, Serbia, Sierra Leone, Singapore,
Slovakia, Slovenia, South Africa, South Korea, Spain, Sri Lanka, St. Kitts and Nevis, St. Vincent and
the Grenadines, Suriname, Switzerland, Syria, Taiwan, Tanzania, Thailand, Togo, Tunisia, Turkey,
the United Arab Emirates, the United Kingdom, the United States, Uruguay, U.S. Virgin Islands,
Venezuela, Vietnam, Yemen, and Zimbabwe

634091-001

8-GB memory module (PC3-10600, 1333-MHz, DDR3, shared)

Sequential part number listing
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Spare part number

Description

634400-001

Qualcomm Gobi 3000 HSPA/CDMA WWAN module with GPS for use in Albania, Algeria,
Angola, Antigua and Barbuda, Argentina, Aruba, Australia, Austria, the Bahamas, Bahrain,
Bangladesh, Barbados, Belarus, Belgium, Belize, Benin, Bermuda, Bolivia, Botswana, Brazil, the
British Virgin Islands, Brunei, Bulgaria, Burkina Faso, Burundi, Cambodia, Cameroon, Canada,
Cape Verde, Cayman Islands, the Central African Republic, Chad, Chile, Colombia, the Congo,
Costa Rica, Croatia, Cyprus, the Czech Republic, Denmark, Djibouti, the Dominican Republic,
Ecuador, Egypt, El Salvador, Equatorial Guinea, Estonia, Finland, France, French Guiana, Gabon,
Gambia, Germany, Ghana, Gibraltar, Greece, Grenada, Guinea, Guadeloupe, Guam. Guatemala,
Guinea-Bissau, Guyana, Haiti, Honduras, Hong Kong, Hungary, Iceland, India, Indonesia, Ireland,
Israel, ltaly, the Ivory Coast, Jamaica, Japan, Jordan, Kazakhstan, Kenya, Kiribati, Kuwait,
Kyrgyzstan, Laos, Latvia, Lebanon, Liberia, Liechtenstein, Lithuania, Luxembourg, Madagascar,
Malaysia, Mali, Martinique, Mauritania, Mauritius, Mexico, Montenegro, Morocco, Mozambique,
Namibia, Nepal, the Nether Antilles, the Netherlands, New Zealand, Nicaragua, Niger, Nigeria,
Norway, Oman, Pakistan, Panama, Paraguay, Peru, the Philippines, Poland, Portugal, Puerto Rico,
Qatar, Romania, Russia, Rwanda, Sao Tome and Principe, Saudi Arabia, Senegal, Serbia, Sierra
Leone, Singapore, Slovakia, Slovenia, South Africa, South Korea, Spain, Sri Lanka, St. Kitts and
Nevis, St. Vincent and the Grenadines, Suriname, Switzerland, Syria, Taiwan, Tanzania, Thailand,
Togo, Tunisia, Turkey, the United Arab Emirates, the United Kingdom, the United States, Uruguay,
U.S. Virgin Islands, Venezuela, Vietnam, Yemen, and Zimbabwe

649745-001

System board with Second Generation Intel Core i5 2410M Dual-Core processor [2.3-GHz (turbo
up to 2.9 GHz), 3 MB L3 cache] for use in all countries and regions except Russia and the People's
Republic of China

649746-001

System board with Second Generation Intel Core i5 2520M Dual-Core processor [2.5 GHz (turbo
up to 3.2 GHz), 3 MB L3 cache] for use in all countries and regions except Russia and the People's
Republic of China

649747001

System board with Second Generation Intel Core i5 2540M Dual-Core processor [2.6 GHz (turbo
up to 3.3 GHz), 3 MB L3 cache] for use in all countries and regions except Russia and the People's
Republic of China

649748-001

System board with Second Generation Intel Core i7 2620M Dual-Core processor [2.7 GHz (turbo
up to 3.4 GHz), 4 MB L3 cache] for use in all countries and regions except Russia and the People's
Republic of China

649749-001

System board with Second Generation Intel Core i5 2410M Dual-Core processor [2.3-GHz (turbo
up to 2.9 GHz), 3 MB L3 cache] for use only in Russia and the People's Republic of China

649750001

System board with Second Generation Intel Core i5 2520M Dual-Core processor [2.5 GHz (turbo
up to 3.2 GHz), 3 MB L3 cache] for use only in Russia and the People's Republic of China

649751-001

System board with Second Generation Intel Core i5 2540M Dual-Core processor [2.6-GHz (turbo
up to 3.3 GHz), 3 MB L3 cache | for use only in Russia and the People's Republic of China

649752001

System board with Second Generation Intel Core i7 2620M Dual-Core processor [2.7 GHz (turbo
up to 3.4 GHz), 4 MB L3 cache] for use only in Russia and the People's Republic of China

649753-001

30.7 em (12.1 in) WXGA, LED, AntiGlare touch screen display assembly (includes 2 WLAN
antenna transceivers and 2 WWAN antenna transceivers and cables)

649754-001

30.7 ecm (12.1 in) WXGA, LED, AntiGlare touch screen display assembly for use outdoors (includes
2 WLAN antenna transceivers and 2 WWAN antenna transceivers and cables)

649756001

Keyboard with TouchPad and pointing stick for use in the United States (includes buttons and cables)

649756-031

Keyboard with TouchPad and pointing stick for use in the United Kingdom (includes buttons and
cables)

649756-041

Keyboard with TouchPad and pointing stick for use in Germany (includes buttons and cables)
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Spare part number

Description

649756-051 Keyboard with TouchPad and pointing stick for use in France (includes buttons and cables)
649756-061 Keyboard with TouchPad and pointing stick for use in ltaly (includes buttons and cables)
649756-071 Keyboard with TouchPad and pointing stick for use in Spain (includes butions and cables)
649756081 Keyboard with TouchPad and pointing stick for use in Denmark (includes buttons and cables)
649756-091 Keyboard with TouchPad and pointing stick for use in Norway (includes buttons and cables)
649756-121 Keyboard with TouchPad and pointing stick for use in French Canada (includes buttons and cables)
649756-131 Keyboard with TouchPad and pointing stick for use in Portugal (includes buttons and cables)
649756-141 Keyboard with TouchPad and pointing stick for use in Turkey (includes buttons and cables)
649756-161 Keyboard with TouchPad and pointing stick for use in Latin America (includes buttons and cables)
649756-171 Keyboard with TouchPad and pointing stick for use in Saudi Arabia (includes buttons and cables)
649756-201 Keyboard with TouchPad and pointing stick for use in Brazil (includes buttons and cables)
649756211 Keyboard with TouchPad and pointing stick for use in Hungary (includes buttons and cables)
649756-251 Keyboard with TouchPad and pointing stick for use in Russia (includes buttons and cables)
649756-261 Keyboard with TouchPad and pointing stick for use in Bulgaria (includes buttons and cables)
649756-281 Keyboard with TouchPad and pointing stick for use in Thailand (includes buttons and cables)
649756291 Keyboard with TouchPad and pointing stick for use in Japan (includes buttons and cables)
649756-A41 Keyboard with TouchPad and pointing stick for use in Belgium (includes buttons and cables)
649756-A81 Keyboard with TouchPad and pointing stick for use in the Czech Republic and Slovakia (includes
buttons and cables)
649756-AB1 Keyboard with TouchPad and pointing stick for use in Taiwan (includes buttons and cables)
649756-AD1 Keyboard with TouchPad and pointing stick for use in Korea (includes buttons and cables)
649756-B31 Keyboard with TouchPad and pointing stick for use internationally (includes buttons and cables)
649756871 Keyboard with TouchPad and pointing stick for use in Sweden and Finland (includes buttons and
cables)
649756-BB1 Keyboard with TouchPad and pointing stick for use in Israel (includes buttons and cables)
649756-BG1 Keyboard with TouchPad and pointing stick for use in Switzerland (includes butions and cables)
649756-DD1 Keyboard with TouchPad and pointing stick for use in Iceland (includes buttons and cables)
649756-DH1 Keyboard with TouchPad and pointing stick for use in Denmark, Finland, Norway, and Sweden
(includes buttons and cables)
649756-D)1 Keyboard with TouchPad and pointing stick for use in Greece (includes buttons and cables)
649756-DW1 Keyboard with TouchPad and pointing stick for use in Northwest Africa (includes buttons and cables)
649757-001 Base enclosure (includes latch)
649758-001 Cable Kit
649759-001 Fan/heat sink assembly (includes replacement thermal material)
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Spare part number Description

649760001 System board shield

649762-001 Audio connector board

649764001 Plastics Kit

649765-001 Rubber Kit (includes feet)

649766-001 Screw Kit

649767001 Speaker assembly

649768001 Top cover assembly (includes TouchPad board, QuickWeb button, and capacitive board)
649769-001 RTC battery

653017-001 128 GB solid-state drive (includes bracket)

653018-001 160 GB solid-state drive (includes bracket)

656619-001 Hard drive, 250 GB, 7200 rpm, SATA 7 mm (2.5 in)

656620001 Hard drive, 320 GB, 7200 rpm, SATA 7 mm (2.5 in)

656621001 Hard drive, 320 GB, 7200 rpm, SATA 7 mm (2.5 in) self-encrypting drive (SED)
657835-001 External Antenna
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4 Removal and replacement
procedures

Preliminary replacement requirements

Tools required

You will need the following tools to complete the removal and replacement procedures:
e  Flat-bladed screwdriver
e  Phillips PO and P1 screwdrivers

e Torx T8 screwdriver

Service considerations

The following sections include some of the considerations that you must keep in mind during
disassembly and assembly procedures.

E/?NOTE: As you remove each subassembly from the computer, place the subassembly (and all
accompanying screws) away from the work area to prevent damage.

Plastic parts

/\ CAUTION: Using excessive force during disassembly and reassembly can damage plastic parts. Use
care when handling the plastic parts. Apply pressure only at the points designated in the maintenance
instructions.

Preliminary replacement requirements
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Cables and connectors

/\ CAUTION: When servicing the computer, be sure that cables are placed in their proper locations

during the reassembly process. Improper cable placement can damage the computer.

Cables must be handled with extreme care to avoid damage. Apply only the tension required to unseat
or seat the cables during removal and insertion. Handle cables by the connector whenever possible. In
all cases, avoid bending, twisting, or tearing cables. Be sure that cables are routed in such a way that

they cannot be caught or snagged by parts being removed or replaced. Handle flex cables with

extreme care; these cables tear easily.

Drive handling
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/\ CAUTION: Drives are fragile components that must be handled with care. To prevent damage to the

computer, damage to a drive, or loss of information, observe these precautions:

Before removing or inserting a hard drive, shut down the computer. If you are unsure whether the
computer is off or in Hibernation, turn the computer on, and then shut it down through the operating

system.

Before handling a drive, be sure that you are discharged of static electricity. While handling a drive,
avoid touching the connector.

Before removing a diskette drive or optical drive, be sure that a diskette or disc is not in the drive and
be sure that the optical drive tray is closed.

Handle drives on surfaces covered with at least one inch of shock-proof foam.

Avoid dropping drives from any height onto any surface.
Avoid exposing a hard drive to products that have magnetic fields, such as monitors or speakers.

Avoid exposing a drive to temperature extremes or liquids.

If a drive must be mailed, place the drive in a bubble pack mailer or other suitable form of protective
packaging and label the package “FRAGILE.”
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Grounding guidelines

Electrostatic discharge damage

Electronic components are sensitive to electrostatic discharge (ESD). Circuitry design and structure
determine the degree of sensitivity. Networks built into many integrated circuits provide some
protection, but in many cases, ESD contains enough power to alter device parameters or melt
silicon junctions.

A discharge of static electricity from a finger or other conductor can destroy static-sensitive devices or
microcircuitry. Even if the spark is neither felt nor heard, damage may have occurred.

An electronic device exposed to ESD may not be affected at all and can work perfectly throughout a
normal cycle. Or the device may function normally for a while, and then degrade in the internal layers,
reducing its life expectancy.

/\ CAUTION: To prevent damage to the computer when you are removing or installing internal
components, observe these precautions:

Keep components in their electrostatic-safe containers until you are ready to install them.
Use nonmagnetic tools.

Before touching an electronic component, discharge static electricity by using the guidelines described
in this section.

Avoid touching pins, leads, and circuitry. Handle electronic components as little as possible.

If you remove a component, place it in an electrostatic-safe container.

The following table shows how humidity affects the electrostatic voltage levels generated by different
activities.

/\ CAUTION: A product can be degraded by as little as 700 V.

Typical electrostatic voltage levels

Relative humidity

Event 10% 40% 55%
Walking across carpet 35,000 V 15,000 V 7,500 vV
Walking across vinyl floor 12,000 V 5,000 V 3,000V
Motions of bench worker 6,000 V 800V 400V
Removing DIPS from plastic tube 2,000 V 700V 400V
Removing DIPS from vinyl tray 11,500V 4,000 V 2,000 V
Removing DIPS from Styrofoam 14,500 V 5,000 V 3,500V
Removing bubble pack from PCB 26,500 V 20,000 V 7,000 V
Packing PCBs in foam-lined box 21,000 V 11,000 V 5,000 V

Preliminary replacement requirements



Packaging and transporting guidelines

Follow these grounding guidelines when packaging and transporting equipment:

To avoid hand contact, transport products in static-safe tubes, bags, or boxes.

Protect ESD-sensitive parts and assemblies with conductive or approved containers or packaging.
Keep ESD-sensitive parts in their containers until the parts arrive at static-free workstations.

Place items on a grounded surface before removing items from their containers.

Always be properly grounded when touching a component or assembly.

Store reusable ESD-sensitive parts from assemblies in protective packaging or nonconductive
foam.

Use transporters and conveyors made of antistatic belts and roller bushings. Be sure that
mechanized equipment used for moving materials is wired to ground and that proper materials
are selected to avoid static charging. When grounding is not possible, use an ionizer to dissipate
electric charges.

Workstation guidelines
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Follow these grounding workstation guidelines:

Cover the workstation with approved static-shielding material.

Use a wrist strap connected to a properly grounded work surface and use properly grounded tools
and equipment.

Use conductive field service tools, such as cutters, screwdrivers, and vacuums.

When fixtures must directly contact dissipative surfaces, use fixtures made only of static-safe
materials.

Keep the work area free of nonconductive materials, such as ordinary plastic assembly aids and
Styrofoam.

Handle ESD-sensitive components, parts, and assemblies by the case or PCM laminate. Handle
these items only at static-free workstations.

Avoid contact with pins, leads, or circuitry.

Turn off power and input signals before inserting or removing connectors or test equipment.
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Equipment guidelines

Grounding equipment must include either a wrist strap or a foot strap at a grounded workstation.

When seated, wear a wrist strap connected to a grounded system. Wrist straps are flexible straps
with a minimum of one megohm +10% resistance in the ground cords. To provide proper ground,
wear a strap snugly against the skin at all times. On grounded mats with banana-plug connectors,
use alligator clips to connect a wrist strap.

When standing, use foot straps and a grounded floor mat. Foot straps (heel, toe, or boot straps)
can be used at standing workstations and are compatible with most types of shoes or boots. On
conductive floors or dissipative floor mats, use foot straps on both feet with a minimum of one
megohm resistance between the operator and ground. To be effective, the conductive strips must
be worn in contact with the skin.

The following grounding equipment is recommended to prevent electrostatic damage:

Antistatic tape

Antistatic smocks, aprons, and sleeve protectors

Conductive bins and other assembly or soldering aids
Nonconductive foam

Conductive tabletop workstations with ground cords of one megohm resistance
Static-dissipative tables or floor mats with hard ties to the ground
Field service kits

Static awareness labels

Material-handling packages

Nonconductive plastic bags, tubes, or boxes

Metal tote boxes

Electrostatic voltage levels and protective materials

The following table lists the shielding protection provided by antistatic bags and floor mats.

Material Use Voltage protection level
Antistatic plastic Bags 1,500V
Carbon-loaded plastic Floor mats 7,500 V
Metallized laminate Floor mats 5,000 V
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Component replacement procedures

This chapter provides removal and replacement procedures.

There are as many as 43 screws in 12 different sizes, that must be removed, replaced, or loosened
when servicing the computer. Make special note of each screw size and location during removal and

replacement.

Service tag
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When ordering parts or requesting information, provide the computer serial number and model

description provided on the service tag.

?

@
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seriat: 3000000000 I RILNIENIEN

Product xcooocoueood | [ NIRRT

= Warranty: XyXyxy
Component Description

1) Product name The product name affixed to the front of your
computer.

(2) Serial number An alphanumeric identifier that is unique to each
product.

(3) Product part number The identifier that provides specific information about
the product's hardware components. The part number
helps a service technician fo determine what
components and parts are needed.

4) Warranty The duration of the warranty period for this computer.
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Computer feet

The computer feet are adhesive-backed rubber pads. The feet are included in the Rubber Kit, spare part
number 649765-001. There are four rubber feet that attach to the base enclosure in the locations
illustrated below.

e
I
I
I
I
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Pen

Description Spare part number

Digitizer pen with eraser (includes tether) 606899-001

Remove the pen:
1. Position the computer right-side up, with the left side toward you.

2. Pull the loop on the tether until it is large enough to pass the pen through it, and then pull the pen
through the loop (1).

3. Remove the pen and tether from the computer (2).

Reverse this procedure to install the pen.
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Battery

Description Spare part number
6-cell, 44 Whr, 2.0 Ah, Li-ion battery 454668-001
6-cell, 39 Whr, 2.0 Ah, Li-ion battery 593592-001

Before disassembling the computer, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.

Remove the battery:

1. Turn the computer upside-down on a flat surface, with the battery bay toward you.
2. Slide the battery release latch (1) to release the battery.

3. Pivot the edge of the battery upward (2) and remove it from the computer (3).

To insert the battery, insert the front edge of the battery into the battery bay and pivot the rear edge of
the battery downward until it is seated. The battery release latch automatically locks the battery into
place.
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Service access cover

@NOTE: The service access cover is included in the Plastics Kit, spare part number 649764-001.

Before removing the service access cover, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 43)

Remove the service access cover:
1. Position the computer upside-down, with the front toward you.

2. Lloosen the three Phillips M2.0x3.0 captive screws (1) that secure the service access cover to the
computer.

3. Lift the rear edge of the service access cover (2) until it rests at an angle, and then remove the
cover.

Reverse this procedure to install the service access cover.
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Primary memory module

Description Spare part number
2 GB (PC3-10600, 1333 MHz, DDR3) 621565-001
4 GB (PC3-10600, 1333 MHz, DDR3) 621569-001
8 GB (PC3-10600, 1333 MHz, DDR3) 634091-001

Update BIOS before adding memory modules

Before adding new memory, make sure you update the computer to the latest BIOS.

/\ CAUTION: Failure to update the computer to the latest BIOS prior to installing new memory may
result in various system problems.

To update BIOS:

1.
2,
3.

4.
5.
6.
7.
8.

Navigate to www.hp.com.
Click Support & Drivers > click Drivers & Software.

In the Enter a product name/number box, type the computer model information, and then
click Search.

Click the link for the computer model.

Select the operating system, and then click Next.

Under Step 2: Select a Download, click the BIOS link.
Click the link for the most recent BIOS.

Click the Download button, and then follow the on-screen instructions.

Before removing the memory module, follow these steps:

1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

Disconnect all external devices connected to the computer.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.

Remove the following components:

a. Remove the battery (see Battery on page 43)

b. Remove the service access cover (see Service access cover on page 44)

Remove the primary memory module:

1.

Spread the retaining tabs (1) on each side of the memory module slot to release the memory
module. (The edge of the module opposite the slot rises away from the computer.)

Component replacement procedures

45



2. Remove the memory module (2) by pulling the module away from the slot at an angle.

[/ NOTE:  Memory modules are designed with a notch (3) to prevent incorrect insertion into the
memory module slot.

Reverse this procedure to install a primary memory module.
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SIM

[Bf NOTE: This section applies only to computer models with WWAN capability.

E"%NOTE: If there is a SIM inserted in the SIM slot, it must be removed before disassembling the
computer. Be sure that the SIM is reinserted in the SIM slot after reassembling the computer.

Before removing the SIM, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.

4. Remove the following components:

a. Remove the battery (see Battery on page 43)

b. Remove the service access cover (see Service access cover on page 44)

¢. Remove the memory module (see Primary memory module on page 45)
Remove the SIM:
1. Press in on the SIM (1). (The module is partially ejected from the SIM slot.)
2. Remove the SIM from the SIM slot.

Reverse this procedure to install the SIM.
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Hard drive

@NOTE: The hard drive spare part kits include the bracket and the screws.

Description Spare part number
320 GB, 7200 rpm, 7 mm (2.5 in) SED hard drive 656621-001
320 GB, 7200 rpm, 7 mm (2.5 in) hard drive 656620-001
250 GB, 7200 rpm, 7 mm (2.5 in) hard drive 656619-001
160 GB solid-state drive (SSD) 653018-001
128 GB SSD 653017-001

Before removing the hard drive, follow these steps:

1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

Disconnect all external devices connected to the computer.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.

Remove the following components:

a. Remove the battery (see Battery on page 43)

b. Remove the service access cover (see Service access cover on page 44)

Remove the hard drive:

1.

2,

Loosen the Phillips M2.5x8.0 captive screw (1) that secures the hard drive bracket to the
computer.

Grasp the tab on the hard drive and slide it forward to disconnect the hard drive.
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3. Lift the hard drive (2) to remove it from the computer.

4. Ifitis necessary to replace the hard drive bracket, remove the four Phillips M2.5x3.0 screws (1)
that secure the bracket to the hard drive.

5. Lift the bracket (2) straight up to remove it from the hard drive.

e

Reverse this procedure to reassemble and install the hard drive.
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WLAN module

/\ CAUTION: The WLAN module and the WWAN module are not interchangeable.

Description Spare part number

Broadcom 43224 802.11 a/b/g/n 2x2 WiFi Adapter: For use in Antigua and Barbuda, 582564-001
Argentina, Aruba, the Bahamas, Barbados, Belize, Bermuda, Bolivia, Brazil, the British Virgin

Islands, Canada, Cayman Islands, Chile, Colombia, Costa Rica, the Dominican Republic, Ecuador,

El Salvador, French Guiana, Grenada, Guadeloupe, Guam, Guatemala, Guyana, Haiti, Honduras,

Jamaica, Martinique, Mexico, the Nether Antilles, Nicaragua, Panama, Paraguay, Peru, Puerto

Rico, St. Kitts and Nevis, St. Vincent and the Grenadines, Suriname, the United States, Uruguay,

U.S. Virgin Islands, and Venezuela

Broadcom 43224 802.11 a/b/g/n 2x2 WiFi Adapter: For use in Albania, Algeria, Angola, 582564-002
Australia, Austria, Bahrain, Bangladesh, Belarus, Belgium, Benin, Botswana, Brunei, Bulgaria,
Burkina Faso, Burundi, Cambodia, Cameroon, Cape Verde, the Central African Republic, Chad,
the People's Republic of China, the Congo, Croatia, Cyprus, the Czech Republic, Denmark,
Djibouti, Egypt, Equatorial Guinea, Estonia, Finland, France, Gabon, Gambia, Germany, Ghana,
Gibraltar, Greece, Guinea, Guinea-Bissau, Hong Kong, Hungary, Iceland, India, Indonesia,
Ireland, Israel, ltaly, the Ivory Coast, Japan, Jordan, Kenya, Kiribati, Kuwait, Kyrgyzstan, Laos,
Latvia, Lebanon, Liberia, Liechtenstein, Lithuania, Luxembourg, Madagascar, Malaysia, Mali,
Mauritania, Mauritius, Montenegro, Morocco, Mozambique, Namibia, Nepal, the Netherlands,
New Zealand, Niger, Nigeria, Norway, Oman, Pakistan, the Philippines, Poland, Portugal, Qatar,
Romania, Russia, Rwanda, Sao Tome and Principe, Saudi Arabia, Senegal, Serbia, Sierra Leone,
Singapore, Slovakia, Slovenia, South Africa, South Korea, Spain, Sri Lanka, Switzerland, Syria,
Taiwan, Tanzania, Thailand, Togo, Tunisia, Turkey, the United Arab Emirates, the United Kingdom,
Vietnam, Yemen, and Zimbabwe
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Description

Spare part number

Broadcom 4322 AGN 802.11a/b/g/draftn WLAN module: For use in Albania, Algeria, Angola,
Antigua and Barbuda, Argentina, Aruba, Australia, Austria, the Bahamas, Bahrain, Bangladesh,
Barbados, Belarus, Belgium, Belize, Benin, Bermuda, Bolivia, Botswana, Brazil, the British Virgin
Islands, Brunei, Bulgaria, Burkina Faso, Burundi, Cambodia, Cameroon, Canada, Cape Verde,
Cayman Islands, the Central African Republic, Chad, Chile, the People's Republic of China,
Colombia, the Congo, Costa Rica, Croatia, Cyprus, the Czech Republic, Denmark, Djibouti, the
Dominican Republic, Ecuador, Egypt, El Salvador, Equatorial Guinea, Estonia, Finland, France,
French Guiana, Gabon, Gambia, Germany, Ghana, Gibraltar, Greece, Grenada, Guineq,
Guadeloupe, Guam. Guatemala, Guinea-Bissau, Guyana, Haiti, Honduras, Hong Kong, Hungary,
Iceland, India, Indonesia, Ireland, Israel, ltaly, the Ivory Coast, Jamaica, Japan, Jordan, Kenya,
Kiribati, Kuwait, Kyrgyzstan, Laos, Latvia, Lebanon, Liberia, Liechtenstein, Lithuania, Luxembourg,
Madagascar, Malaysia, Mali, Martinique, Mauritania, Mauritius, Mexico, Montenegro, Morocco,
Mozambique, Namibia, Nepal, the Nether Antilles, the Netherlands, New Zealand, Nicaragua,
Niger, Nigeria, Norway, Oman, Pakistan, Panama, Paraguay, Peru, the Philippines, Poland,
Portugal, Puerto Rico, Qatar, Romania, Russia, Rwanda, Sao Tome and Principe, Saudi Arabia,
Senegal, Serbia, Sierra Leone, Singapore, Slovakia, Slovenia, South Africa, South Korea, Spain,
Sri Lanka, St. Kitts and Nevis, St. Vincent and the Grenadines, Suriname, Switzerland, Syria,
Taiwan, Tanzania, Thailand, Togo, Tunisia, Turkey, the United Arab Emirates, the United Kingdom,
the United States, Uruguay, U.S. Virgin Islands, Venezuela, Vietnam, Yemen, and Zimbabwe

593836-001

Intel Centrino Advanced-N6205 (2x2) WiFi Adapter: For use in Albania, Algeria, Angola, Antigua
and Barbuda, Argentina, Aruba, Australia, Austria, the Bahamas, Bahrain, Bangladesh, Barbados,
Belarus, Belgium, Belize, Benin, Bermuda, Bolivia, Botswana, Brazil, the British Virgin Islands,
Brunei, Bulgaria, Burkina Faso, Burundi, Cambodia, Cameroon, Canada, Cape Verde, Cayman
Islands, the Central African Republic, Chad, Chile, the People's Republic of China, Colombia, the
Congo, Costa Rica, Croatia, Cyprus, the Czech Republic, Denmark, Djibouti, the Dominican
Republic, Ecuador, Egypt, El Salvador, Equatorial Guinea, Estonia, Finland, France, French
Guiana, Gabon, Gambia, Germany, Ghana, Gibraltar, Greece, Grenada, Guinea, Guadeloupe,
Guam. Guatemala, Guinea-Bissau, Guyana, Haiti, Honduras, Hong Kong, Hungary, Iceland, India,
Indonesia, Ireland, Israel, ltaly, the Ivory Coast, Jamaica, Japan, Jordan, Kenya, Kiribati, Kuwait,
Kyrgyzstan, Laos, Latvia, Lebanon, Liberia, Liechtenstein, Lithuania, Luxembourg, Madagascar,
Malaysia, Mali, Martinique, Mauritania, Mauritius, Mexico, Montenegro, Morocco, Mozambique,
Namibia, Nepal, the Nether Antilles, the Netherlands, New Zealand, Nicaragua, Niger, Nigeria,
Norway, Oman, Pakistan, Panama, Paraguay, Peru, the Philippines, Poland, Portugal, Puerto Rico,
Qatar, Romania, Russia, Rwanda, Sao Tome and Principe, Saudi Arabia, Senegal, Serbia, Sierra
Leone, Singapore, Slovakia, Slovenia, South Africa, South Korea, Spain, Sri Lanka, St. Kitts and
Nevis, St. Vincent and the Grenadines, Suriname, Switzerland, Syria, Taiwan, Tanzania, Thailand,
Togo, Turkey, the United Arab Emirates, the United Kingdom, the United States, Uruguay, U.S.
Virgin Islands, Venezuela, Vietnam, Yemen, and Zimbabwe

631954-001

Before removing the WLAN module, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the

computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet,

and then unplugging the AC adapter from the computer.
4. Remove the following components:

a. Remove the battery (see Battery on page 43)

b. Remove the service access cover (see Service access cover on page 44)
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Remove the WLAN module:

1. Disconnect the WLAN antenna cables (1) from the terminals on the WLAN module and
disengage them from the channels (2) holding them in place.

E/%’NOTE: The black WLAN antenna cable is connected to the WLAN module “Main” terminal. The
white WLAN antenna cable is connected to the WLAN module “Aux” terminal.

2. Remove the two Phillips M2.5x3.0 screws (3) that secure the WLAN module to the computer.

3. Remove the WLAN module by pulling the module away from the slot at an angle (4).

r__f/i"NOTE: WLAN modules are designed with a notch (5) to prevent incorrect insertion.

Reverse this procedure fo install the WLAN module.
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WWAN module

/\ CAUTION: The WWAN module and the WLAN module are not interchangeable.

Description Spare part number
Ericsson 5521 HSPA+ WWAN module 632155-001
Qualcomm Gobi 3000 HSPA/CDMA WWAN module with GPS (not available in China) 634400-001

Before removing the WWAN module, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.

4. Remove the following components:

a. Remove the battery (see Battery on page 43)

b. Remove the service access cover (see Service access cover on page 44)

Remove the WWAN module:

1. Disconnect the WWAN antenna cables (1) and (2) from the terminals on the WWAN module.

@NOTE: The red WWAN antenna cable is connected to the WWAN module “Main” terminal.
The blue WWAN antenna cable is connected to the WWAN module “Aux” terminal.

2. Remove the two Phillips M2.5x3.0 screws (3) that secure the WWAN module to the computer.
(The edge of the module opposite the slot rises away from the computer.)
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3. Remove the WWAN module (4) by pulling the module away from the slot at an angle.

E/%’NOTE: WWAN modules are designed with a notch (5) to prevent incorrect insertion.

Reverse this procedure to install the WWAN module.
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Keyboard

For use in:

Spare part number

For use in:

Spare part number

Keyboard with TouchPad and pointing stick (includes buttons and cables):

Belgium 649756-A41 Northwest Africa 649756-DW1
Brazil 649756-201 Portugal 649756-131
Bulgaria 649756-261 Russia 649756-251
Denmark 649756-081 Saudi Arabia 649756-171
France 649756-051 Slovakia and The Czech Republic  649756-A81
French Canada 649756-121 South Korea 649756-AD1
Germany 649756-041 Spain 649756-071
Greece 649756-D)1 Sweden and Finland 649756-DH1
Hungary 649756-211 Sweden, Denmark, Norway, 649756-B71
Finland

Iceland 649756-DD1 Switzerland 649756-BG1
International 649756-B31 Taiwan 649756-AB1
Israel 649756-BB1 Thailand 649756-281
ltaly 649756-061 Turkey 649756-141
Japan 649756-291 The United Kingdom 649756031
Latin America 649756-161 The United States 649756-001
Norway 649756-091

Before removing the keyboard, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the

computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet,

and then unplugging the AC adapter from the computer.

4. Remove the following components:

a. Remove the battery (see Battery on page 43)

b. Remove ths service access cover (see Service access cover on page 44)

Remove the keyboard:

1. Turn the computer upside-down, with the front toward you.
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2. Remove the two screw caps (1) and loosen the five captive screws (2) that secure the keyboard to
the computer.

Turn the computer rightside up, with the front toward you.

4. Open the display as far as possible.

Insert a flat tool under the back edge (1) of the keyboard near the display hinge. Gently lift the
rear edge of the keyboard (2) and disconnect the keyboard.
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Holding the keyboard at an angle, lift the keyboard (1) far enough to gain access to the cables
underneath and release the zero insertion force (ZIF) connector (2) to which the pointing stick
cable is attached to the system board and remove the pointing stick ZIF cable (3) from the
connector.

Flip the keyboard over to the left and lay it flat (1), then release the ZIF connector that secures the
keyboard cable (2) to the system board and remove the keyboard cable (3) from the ZIF

connector.
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8. Release the ZIF connector to which the pointing stick cable is attached, and then disconnect the
cable (4) from the keyboard.

9. Remove the keyboard.

Reverse this procedure to install the keyboard.

Secondary memory module

Description Spare part number
1 GB (PC3-10600, 1333 MHz, DDR3) 639738-001
2 GB (PC3-10600, 1333 MHz, DDR3) 621565-001
4 GB (PC3-10600, 1333 MHz, DDR3) 621569-001
8 GB (PC3-10600, 1333 MHz, DDR3) 634091-001

Update BIOS before adding memory modules

Before adding new memory, make sure you update the computer to the latest BIOS.

/\ CAUTION: Failure to update the computer to the latest BIOS prior to installing new memory may
result in various system problems.

To update BIOS:

1. Navigate to www.hp.com.
2. Click Support & Drivers > click Drivers & Software.
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3. In the Enter a product name/number box, type the computer model information, and then
click Search.

Click the link for the computer model.

Select the operating system, and then click Next.

Under Step 2: Select a Download, click the BIOS link.
Click the link for the most recent BIOS.

® N o o s

Click the Download button, and then follow the on-screen instructions.
Before removing the memory module, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.

4. Remove the following components:

a. Remove the battery (see Battery on page 43)

b. Service access cover (see Service access cover on page 44)

¢. Remove the keyboard (see Keyboard on page 55)

Remove the secondary memory module:

1. Spread the refaining tabs (1) on each side of the memory module slot to release the memory
module. (The edge of the module opposite the slot rises away from the computer.)
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2. Remove the memory module (2) by pulling the module away from the slot at an angle.

[/ NOTE:  Memory modules are designed with a notch (3) to prevent incorrect insertion into the
memory module slot.

Reverse this procedure to install a secondary memory module.

Top cover

The top cover kit includes the TouchPad board and capacitive board.

Description Spare part number

Top cover 649768-001

Before removing the top cover, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.

4. Remove the following components:

a. Remove the battery (see Battery on page 43)

b. Remove the service access cover (see Service access cover on page 44)
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c. Remove the keyboard (see Keyboard on page 55)

d. Remove the secondary memory module (see Secondary memory module on page 58)

Remove the top cover:
Turn the computer upside-down, with the front toward you.

2. Remove the two Torx 8M2.0x7.0 screws (1) located in the bottom feet. You do not need to
remove the feet.

3. Remove the two screw caps (2) and the two Torx 8M2.0x5.0 screws (3) located below the
battery bay.

4. Turn the computer rightside up, with the front foward you.
Open the display as far as possible.

6. Release the ZIF connector (1) that secures the audio cable to the system board and remove the
audio cable (2) from the ZIF connector.

7. Release the ZIF connector (3) that secures the TouchPad button cable to the system board and
remove the touchpad button cable (4) from the ZIF connector.
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8. Remove the two Phillips M2.5x7.0 screws (5).

9. Lift the rear edge (1) of the top cover.

10. Disengage the top cover from the computer, and then lift the top cover (2) up and off the
computer.

E%?NOTE: A small plastic brace for the VGA port rests below the top cover. Simply lift the brace.
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11. Remove the Phillips M2.0x2.0 screw (1) from the volume control board and slide the volume
control (2) out from the tab.

Reverse this procedure to install the top cover.
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TouchPad board

@NOTE: The TouchPad board is available with the top cover kit, spare part number 649768-001.

Before removing the TouchPad board, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.

4. Remove the following components:

a. Remove the battery (see Battery on page 43)

b. Remove the service access cover (see Service access cover on page 44)

¢. Remove the keyboard (see Keyboard on page 55)

d. Remove the top cover (see Top cover on page 60)

Remove the TouchPad board:
1. Position the computer rightside up, with the front toward you.

2. Remove the Phillips M2.0x3.5 screw (1) that secures the TouchPad to the top cover.

3. Disconnect the TouchPad cable (2) from the TouchPad board ZIF connector and then slide the
board (3) out from the tab.

Reverse this procedure to install the TouchPad board.
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RTC battery

Description Spare part number

RTC battery 649769-001

Before removing the RTC battery, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.

4. Remove the following components:

a. Remove the battery (see Battery on page 43)

b. Remove the service access cover (see Service access cover on page 44)

c. Remove the keyboard (see Keyboard on page 55)

d. Remove the top cover (see Top cover on page 60)

Remove the RTC battery:

1. Disconnect the RTC battery cable (1) from the system board.

2. Gently pull the battery away from the double-sided tape that secures the battery (2) to the system
board and remove it from the computer.

Reverse this procedure fo install the RTC battery.

Component replacement procedures

65



Display assembly

The display assemblies include two WLAN antenna transceivers and cables and two WWAN antenna
transceivers and cables.

Description Spare part number
30.7 em (12.1 in) WXGA, LED, AntiGlare touch screen display assembly 649753-001
30.7 ecm (12.1 in) WXGA, LED, AntiGlare touch screen display assembly for use outdoors 649754-001

Before removing the display assembly, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.

4. Remove the following components:

a. Remove the battery (see Battery on page 43)

b. Remove the service access cover (see Service access cover on page 44)
c. Remove the WLAN module (see WLAN module on page 50)

d. Remove the WWAN module (see WWAN module on page 53)

e. Remove the keyboard (see Keyboard on page 55)

f. Remove the top cover (see Top cover on page 60)
Remove the display assembly:

1. Position the computer upside down, with the rear toward you.
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2. Remove the two Torx 9 M2.0x5.0 screws that secure the hinge cover to the computer.

3. Position the computer right-side up, with the rear toward you.

4. Slide the hinge cover away from the computer. The hinge cover is available in the Plastics Kit,
spare part number 649764-001.

5. Position the computer right-side up, with the front toward you and open the display so it stands
straight up.

6. Feed the WWAN and WLAN antennas (1) through the bottom of the base enclosure and remove
the antennas.

7. Disconnect the webcam cable (2) from the system board.
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8. Disconnect the display cable (3) from the system board.

A

/\ CAUTION: Support the display assembly when removing the display screws in the following
step. Failure to support the display assembly can result in damage to the assembly and other
components.

9. Remove the two Phillips M2.5x6.0 screws (1) that secure the display assembly to the base
enclosure.

10. Gently rotate the display (2) and swivel it at a 90-degree angle to gain access to the remaining
screws in the display bracket.

11. Remove the two Phillips M2.5 x 6.0 screws (3) that secure the display bracket to the base
enclosure.

68 Chapter 4 Removal and replacement procedures



12. Lift the display straight up to remove it from the base enclosure (4).

Reverse this procedure to reassemble and install the display assembly.

System board shield

Description Spare part number

System board shield 649760-001

Before removing the system board shield, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

Disconnect all external devices connected to the computer.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.

4. Remove the following components:

Remove the battery (see Battery on page 43)

a

b. Remove the service access cover (see Service access cover on page 44)
Remove the WLAN module (see WLAN module on page 50)

Remove the WWAN module (see WWAN module on page 53)

0
.

e

e. Remove the keyboard (see Keyboard on page 55)
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f. Remove the top cover (see Top cover on page 60)

g. Remove the display assembly (see Display assembly on page 66)
Remove the system board shield:
1. Position the computer rightsside up, with the front toward you.

2. Remove the four Phillips M2.5x3.0 screws (1) and (2) that secure the shield to the base

enclosure.

3. Slide the shield from the computer (3).

/\ WARNING! Use caution when handling the system shield as the object may be hot.

Reverse this procedure to install the system board shield.

[/ NOTE:  When installing a replacement system board shield, take care that the tab labeled “Watch
Out” is inserted correctly under the heat sink so that the keyboard lies flat when replaced.

Modem module

@NOTE: The modem module spare part kit does not include a modem module cable. The modem
module cable is included in the Cable Kit, spare part number 649758-001. See Cable Kit on page 25
for more Cable Kit spare part number information.

Description Spare part number

Modem module 628824-001
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Before removing the modem module, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.

4. Remove the following components:

a. Remove the battery (see Battery on page 43)

b. Remove the service access cover (see Service access cover on page 44)
c. Remove the WLAN module (see WLAN module on page 50)

d. Remove the WWAN module (see WWAN module on page 53)

e. Remove the keyboard (see Keyboard on page 55)

f. Remove the top cover (see Top cover on page 60)

g. Remove the display assembly (see Display assembly on page 66)

h. Remove the system board shield (see System board shield on page 69)
Remove the modem module:
1. Turn the computer right-side up, with the front toward you.

2. Disconnect the modem module (1) from the system board by lifting it straight up.

3. Disconnect the modem module cable (2) from the modem module, and then remove the module
from the computer.

Reverse this procedure to install the modem module.
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Bluetooth module

@NOTE: The Bluetooth module spare part kit does not include a Bluetooth module cable. The Bluetooth
module cable is included in the Cable Kit, spare part number 649758-001. See Cable Kit on page 25
for more Cable Kit spare part number information.

Description Spare part number

Bluetooth module 537921-001

Before removing the Bluetooth module, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.

4. Remove the following components:

a. Remove the battery (see Battery on page 43)

b. Remove the service access cover (see Service access cover on page 44)
c. Remove the WLAN module (see WLAN module on page 50)
d. Remove the WWAN module (see WWAN module on page 53)

e. Remove the keyboard (see Keyboard on page 55)

Remove the top cover (see Top cover on page 60)

g. Remove the display assembly (see Display assembly on page 66)

Remove the Bluetooth module:

1. Position the computer right-side up, with the front toward you.

2. Lift the Bluetooth module (1) as far as the cable will allow.
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3. Disconnect the Bluetooth module cable from the Bluetooth module (2) and remove the module.

Reverse this procedure to reassemble and install the Bluetooth module.

Latch assembly

E’%NOTE: The Latch Kit includes the latch, bracket, two screws, and spring.

Description Spare part number

Latch Kit 597837-001

Before removing the latch assembly, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.

4. Remove the following components:

a. Remove the battery (see Battery on page 43)

b. Remove the service access cover (see Service access cover on page 44)
c. Remove the WLAN module (see WLAN module on page 50)
d. Remove the WWAN module (see WWAN module on page 53)

e. Remove the keyboard (see Keyboard on page 55)

Component replacement procedures

73



f. Remove the top cover (see Top cover on page 60)

g. Remove the display assembly (see Display assembly on page 66)

@NOTE: The latch mechanism includes a small spring. Note the location of the spring.

Remove the latch assembly:
1. Position the computer rightsside up, with the front toward you.
Detach the spring (1) from the latch.

2
3. Remove the two Phillips M2.0x4.0 screws (2) that secure the latch bracket to the base enclosure.
4

Lift the inner latch (3) from the computer.

Reverse this procedure to install the latch assembly.

Speaker assembly

Description Spare part number

Speaker assembly 649767001

Before removing the speaker assembly, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

74 Chapter 4 Removal and replacement procedures



3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.

4. Remove the following components:

a. Remove the battery (see Battery on page 43)
b. Remove the service access cover (see Service access cover on page 44)
c. Remove the WLAN module (see WLAN module on page 50)
d. Remove the WWAN module (see WWAN module on page 53)
e. Remove the keyboard (see Keyboard on page 55)
Remove the top cover (see Top cover on page 60)
g. Remove the display assembly (see Display assembly on page 66)
h. Remove the Bluetooth module (see Bluetooth module on page 72)

Latch assembly (see Latch assembly on page 73)

Remove the speaker assembly:

Position the computer right-side up, with the front toward you.

2. Unplug the speaker cable (1) from the audio connector board, and note the routing channel of the
speaker cable in the base enclosure.

3. Slide the the speakers and cables (2) from the base enclosure and lift to remove.

Reverse this procedure to install the speaker assembly.
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Audio board
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Description Spare part number

Audio connector board 649762-001

Before removing the audio connector board, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.

4. Remove the following components:

a o T2

o

I @

Remove the battery (see Battery on page 43)

Remove the service access cover (see Service access cover on page 44)
Remove the WLAN module (see WLAN module on page 50)
Remove the WWAN module (see WWAN module on page 53)

Remove the keyboard (see Keyboard on page 55)

Remove the top cover (see Top cover on page 60)

Remove the display assembly (see Display assembly on page 66)

Remove the Bluetooth module (see Bluetooth module on page 72)

Latch assembly (see Latch assembly on page 73)

Remove the speaker assembly (see Speaker assembly on page 74)

Remove the audio connector board:

1. Position the computer right-side up, with the front toward you.

2. Release the ZIF connector (1) that secures the audio board cable to the system board and remove
the audio board cable (2).
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3. Remove the Phillips M2.0x3.5 screw (3) that secures the audio connector board to the base
enclosure and lift the board (4).

Reverse this procedure to install the audio connector board.
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Smart card reader

Description Spare part number

Smart card reader 597839-001

Before removing the smart card reader, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.

4. Remove the following components:

a. Remove the battery (see Battery on page 43)

b. Remove the service access cover (see Service access cover on page 44)
c. Remove the WLAN module (see WLAN module on page 50)

d. Remove the WWAN module (see WWAN module on page 53)

e. Remove the keyboard (see Keyboard on page 55)

f. Remove the top cover (see Top cover on page 60)

g. Remove the display assembly (see Display assembly on page 66)

h. System board shield (see System board shield on page 69)

Remove the smart card reader:

1. Position the computer right-side up, with the front toward you.

2. Disconnect the smart card reader cable from the ZIF connector (1) on the system board and
remove the cable (2).
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3. Lift the smart card reader out of the chassis (3).

%NOTE: Adhesive secures the reader to the base enclosure. You must break the adhesion to
remove the reader.

4. Remove the Bluetooth cable by disconnecting the ZIF cable (1) securing the Bluetooth module to
the system board and thn lift the cable (2).

Reverse this procedure to install the smart card reader.
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System board

80

@NOTE: The system board spare part kits include replacement thermal material.

Description

Spare part number

For use in all countries and regions except Russia and the People's Republic of China:

e Equipped with Intel Core i7-2620M 2620M, 2.7 GHz (turbo up to 3.4 GHz) processor, 4 MB  649748-001
L3 cache, 35W

e  Equipped with Intel Core i5-2410M, 2.3 GHz (turbo up to 2.9 GHz) processor, 3 MB L3 649745-001
cache, 35W (select models only)

e  Equipped with Intel Core i5-2520M, 2.5 GHz (turbo up to 3.2 GHz) processor, 3 MB L3 649746-001
cache, 35W

For use only in Russia and the People's Republic of China:

e  Equipped with Second Generation Intel Core i5-2410M Dual-Core processor [2.3 GHz (turbo 649749001
up to 2.9 GHz), 3 MB L3 cache]

e quipped with Second Generation Intel Core i5-2520M Dual-Core processor [2.5 GHz (turbo ~ 649750-001
up to 3.2 GHz), 3 MB L3 cache]

e  Equipped with Second Generation Intel Core i5-2540M Dual-Core processor [2.6 GHz (turbo  649751-001
up to 3.3 GHz), 3 MB L3 cache]

e  Equipped with Second Generation Intel Core i7-2620M Dual-Core processor [2.7 GHz (turbo  649752-001

up to 3.4 GHz), 4 MB L3 cache]

Before removing the system board, follow these steps:

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the

computer on, and then shut it down through the operating system.

Disconnect all external devices connected to the computer.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet,

and then unplugging the AC adapter from the computer.
Remove the following components:

a. Remove the battery (see Battery on page 43)

b. Remove the service access cover (see Service access cover on page 44)

¢. Remove the SIM card (see SIM on page 47)

d. Remove the memory module (see Primary memory module on page 45)

e. Remove the hard drive (see Hard drive on page 48)
f. Remove the WLAN module (see WLAN module on page 50)
g. Remove the WWAN module (see WWAN module on page 53)

h. Remove the keyboard (see Keyboard on page 55)

i.  Remove the top cover (see Top cover on page 60)
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j-  Remove the RTC battery (see RTC battery on page 65)

k. Remove the display assembly (see Display assembly on page 66)

I.  Remove the system board shield (see System board shield on page 69)

m. Remove the smart card reader (see Smart card reader on page 78)

When replacing the system board, be sure that the following components are removed from the
defective system board and installed on the replacement system board:

e  Remove the SIM (see SIM on page 47)

e  Remove the memory modules (see Primary memory module on page 45 and Secondary memory
module on page 58)

e Remove the WLAN module (see WLAN module on page 50)
e Remove the WWAN module (see WWAN module on page 53)

e  Remove the modem module (see Modem module on page 70)

e  Remove the heat sink (see Fan/heat sink assembly on page 82)

Remove the system board:
1. Position the computer rightside up, with the front toward you.

2. Remove the ExpressCard or ExpressCard slot holder.

3. Peel back the adhesive strip (2) on the system board to reveal one of the two screws required to
remove the system board.

4. Remove the two Phillips M2.0x4.0 screws (2) that secure the system board to the base enclosure.
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5. Lift the right side of the system board, and remove it from the base enclosure (3).

Reverse this procedure fo install the system board.

Fan/heat sink assembly

82

The heat sink spare part kit includes replacement thermal material.

Description Spare part number

Fan/heat sink assembly 649759001

Before removing the fan/heat sink assembly, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.

4. Remove the following components:

a.
b.
c.

d.

e.

Remove the battery (see Battery on page 43)

Remove the service access cover (see Service access cover on page 44)

Remove the SIM card (see SIM on page 47)

Remove the memory module (see Primary memory module on page 45)

Remove the hard drive (see Hard drive on page 48)

Chapter 4 Removal and replacement procedures



-
h

Remove the WLAN module (see WLAN module on page 50)
Remove the WWAN module (see WWAN module on page 53)

= @

Remove the keyboard (see Keyboard on page 55)

Remove the top cover (see Top cover on page 60)

j-  Remove the RTC battery (see RTC battery on page 65)

k. Remove the display assembly (see Display assembly on page 66)

.  Remove the system board shield (see System board shield on page 69)

m. Remove the smart card reader (see Smart card reader on page 78)

n. Remove the system board (see System board on page 80)
Remove the fan/heat sink assembly:
1. Position the system board right side up.

2. Disconnect the fan cable from the system board.

3. Position the system board upside down.

4. In the order indicated on the heat sink, loosen the four Phillips captive screws (1) that secure the
heat sink to the base enclosure.
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5. Remove the fan/heat sink assembly (2).

@NOTE: The thermal material must be thoroughly cleaned from the surfaces of the heat sink (1) and
processor (2) each time the heat sink is removed. Thermal material is included with fan/heat sink
assembly and system board spare part kits.

Reverse this procedure to install the fan/heat sink assembly.
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5 Computer Setup

Starting Computer Setup

Computer Setup is a preinstalled, ROM-based utility that can be used even when the operating system
is not working or will not load.

r__":"/?NOTE: Some of the Computer Setup menu items listed in this guide may not be supported by your
computer.

r__":"/?NOTE: An external keyboard or mouse connected to a USB port can be used with Computer Setup
only if USB legacy support is enabled.

To start Computer Setup, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

2. Press f10 to enter BIOS Setup.

Using Computer Setup

Navigating and selecting in Computer Setup

The information and settings in Computer Setup are accessed from the File, Security, and System
Configuration menus.

To navigate and select in Computer Setup, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

e To select a menu or a menu item, use the tab key and the keyboard arrow keys, and then
press enter, or use a pointing device to click the item.

e To scroll up and down, click the up arrow or the down arrow on the right side of the screen,
or use the up arrow key or the down arrow key.

e To close open dialog boxes and return to the main Computer Setup screen, press esc, and
then follow the on-screen instructions.

@NOTE: You can use either a pointing device (TouchPad, pointing stick, or USB mouse) or the
keyboard to navigate and make selections in Computer Setup.

2. Press {10 to enter BIOS Setup.

3. Select the File, Security, or System Configuration menu.
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To exit Computer Setup menus, choose one of the following methods:

To exit Computer Setup menus without saving your changes, click the Exit icon in the lower-left
corner of the screen, and then follow the on-screen instructions.

- or —

Use the tab key and the arrow keys to select File > Ignore Changes and Exit, and then press
enter.

To save your changes and exit Computer Setup menus, click the Save icon in the lower-left corner
of the screen, and then follow the on-screen instructions.

—or —

Use the tab key and the arrow keys to select File > Save Changes and Exit, and then press
enter.

Your changes go into effect when the computer restarts.

Restoring factory settings in Computer Setup

@NOTE: Restoring defaults will not change the hard drive mode.

To return all seftings in Computer Setup to the values that were set at the factory, follow these steps:

1.

L

Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

Press {10 to enter BIOS Setup.
Use a pointing device or the arrow keys to select File > Restore Defaults.

Follow the on-screen instructions.

To save your changes and exit, click the Save icon in the lower-left corner of the screen, and then
follow the on-screen instructions.

- or —

Use the arrow keys to select File > Save Changes and Exit, and then press enter.

Your changes go into effect when the computer restarts.

E/?’NOTE: Your password settings and security settings are not changed when you restore the factory
seftings.
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Computer Setup menus

The menu tables in this section provide an overview of Computer Setup options.

E’jNOTE: Some of the Computer Setup menu items listed in this chapter may not be supported by your

computer.
il
File menu

Select To do this

System Information e  View identification information for the computer and the

batteries in the system.

e  View specification information for the processor, cache
and memory size, system ROM, video revision, and
keyboard controller version.

Set System Date and Time Set or change the date and time on the computer.

System Diagnostics Displays the following information:

e  System Information
o Identification information for the computer and the

batteries in the system.

o Specification information for the processor, cache
and memory size, system ROM, video revision, and
keyboard controller version.

e  Startup Test—Verifies the system components needed for
starting the computer.

e  Run-n Test—Runs a comprehensive check on system
memory.

e  Hard Disk Test—Runs a comprehensive selftest on any
hard drive in the system.

e  Memory Test—Runs a comprehensive test on any
memory installed in the computer.

e  Battery Test—Runs a comprehensive test on any batteries
installed in the computer.

e  Error Log—Displays a log file if any errors have
occurred.

Restore Defaults Replace the configuration settings in Computer Setup with the
original factory seftings. (Hard drive mode, password settings,
and security settings are not changed when you restore the
factory settings.)

Reset BIOS security to factory default Restore the BIOS security settings to the factory default.
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Select

To do this

Ignore Changes and Exit

Cancel any changes entered during the current session. Then
exit and restart the computer.

Save Changes and Exit

Save any changes entered during the current session. Then
exit and restart the computer. Your changes go into effect
when the computer restarts.

Security menu
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@NOTE: Some of the menu items listed in this section may not be supported by your computer.

Select

To do this

Setup BIOS Administrator Password

Set up a BIOS administrator password.

User Management > Create New BIOS User Account (requires
a BIOS administrator password)

e Select from a list of BIOS users.

e  Select from a list of ProtectTools users.

Password Policy (requires a BIOS administrator password)

Revise password policy criteria.

HP SpareKey

Enable/disable HP SpareKey (enabled by default).

Always Prompt for HP SpareKey Enrollment

Enable/disable HP SpareKey enrollment (enabled by default).

Fingerprint Reset on Reboot (If Present)

Reset/clear the fingerprint reader ownership (select models
only; disabled by defaul).

Change Password

Enter, change, or delete a BIOS administrator password.

HP SpareKey Enrollment

Enroll or reset HP SpareKey, which is a set of security
questions and answers used if you forget your password.

Anti Theft > AT-p

Enable/disable Anti-Theft Protection.

Drivelock Password

e  Enable/disable Drivelock on any computer hard drive

(enabled by default).
e  Change a Drivelock user password or master password.

NOTE: Drivelock settings are accessible only when you
enter Computer Setup by turning on (not restarting) the
computer.

Automatic Drivelock

Enable/disable Automatic Drivelock support.

TPM Embedded Security

Enable/disable support for Trusted Platform Module (TPM)
Embedded Security, which protects the computer from
unauthorized access to owner functions available in
Embedded Security for ProtectTools. For more information,
refer to the ProtectTools software Help.

NOTE: You must have a setup password to change this
setting.
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Select

To do this

Disk Sanitizer

Run Disk Sanitizer to destroy all existing data on the primary
hard drive or the drive in the upgrade bay.

CAUTION: If you run Disk Sanitizer, the data on the
selected drive is destroyed permanently.

System IDs

Enter a user-defined computer asset tracking number and
ownership tag.
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System Configuration menu

@NOTE: Some of the listed System Configuration options may not be supported by your computer.

Select To do this
Language Change the Computer Setup language.
Boot Options e  Seta startup menu delay (in seconds).

Set the MultiBoot Express popup delay (in seconds).
Enable/disable custom logo (disabled by default).

Enable/disable display diagnostic URL (enabled by
default).

Enable/disable CD-ROM boot (enabled by default).
Enable/disable SD card boot (enabled by default).
Enable/disable floppy boot (enabled by default).

Enable/disable PXE internal NIC boot (enabled by
default).

Enable/Disable Unified Extensible Firmware Interface
(UEFI) Boot Mode (disabled by default).

Set the legacy boot order.

Device Configurations °

Enable/disable USB legacy support (enabled by default).
When enabled, USB legacy support allows the following:

o Use of a USB keyboard in Computer Setup even
when a Windows operating system is not running

o Startup from bootable USB devices, including a
hard drive, diskette drive, or optical drive
connected by a USB port to the computer

Enable/disable fan always on while connected to an AC
outlet (disabled by default).

Enable/disable Data Execution Prevention (select models
only). When enabled, the processor can disable some
virus code execution, which helps to improve computer

security (disabled by default).

Select a SATA (Serial Advanced Technology Aftachment)
device mode. The following options are available:

o AHCI (Advanced Host Controller Interface)
> IDE (Integrated Drive Electronics)

o RAID (Redundant Array of Independent Disks) (select
models only)
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Select

To do this

NOTE: Availability of these options varies by computer
model.

e  Enable/disable secondary battery fast charge (enabled
by default).

e  Enable/disable HP Quicklook (enabled by default).

e  Enable/disable preboot authentication on HP QuickLook
boot (enabled by default).

e  Enable/disable HP QuickWeb (enabled by default).

e  Enable/disable HP QuickWeb write protect (disabled by
default).

e  Enable/disable virtualization technology (select models
only; disabled by default).

e  Enable/disable TXT (Intel Trusted Execution Technology)
(select models only; disabled by default).

e  Enable/disable Multi Core CPU (enabled by default).
e  Enable/disable Intel HT Technology (enabled by default).
e  Enable/disable Wake on USB (enabled by default).

e  Enable/disable Num lock state at boot (disabled by
default).

Computer Setup menus
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Select

To do this

Built-In Device Options

Enable/disable the wireless button state (enabled by
default).

Enable/disable embedded WWAN device radio (select
models only; enabled by default).

Enable/disable embedded WLAN device radio (select
models only; enabled by default).

Enable/disable the embedded Bluetooth device radio
(enabled by default).

Enable/disable the network interface controller (enabled

by default).

Enable/disable LAN/WLAN switching (disabled by
default).

Set the wake on LAN state. Options include the
following:

Disabled
Boot to Network
Follow Boot Order
Enable/disable the ambient light sensor.

Enable/disable the fingerprint device (enabled by
default).

Enable/disable the integrated camera (enabled by
default).

Enable/disable the power monitor circuit (enabled by

defaul).
Enable/disable the audio device (enabled by default).
Enable/disable a modem device (enabled by default).
Enable/disable the microphone (enabled by defaul).

Enable/disable the internal speakers (enabled by
default).

Port Options

NOTE: All port options are enabled by default.

Enable/disable the flash media reader.
Enable/disable the USB port.

CAUTION: Disabling the USB port also disables
MultiBay devices and ExpressCard devices on the
advanced port replicator.

Enable/disable the 1394 port.
Enable/disable the ExpressCard slot.
Enable/disable the Smart card slot.

Enable/disable the eSATA port.
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Select

To do this

AMT Options

NOTE: All AMT options are disabled by default.

Enable/disable firmware verbosity.
Enable/disable AMT setup prompt (Ctrl-P).
Enable/disable USB key provisioning support.
Enable/disable unconfigure AMT on next boot.
Select terminal emulation mode:

° ANSI

- VT100

Enable/disable firmware progress event support.

Enable/disable initiate Intel CIRA.

Set Security Level

Change, view, or hide security levels for all BIOS menu items.

Restore Security Defaults

Restore the default security settings.

Computer Setup menus
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6 Specifications

Computer specifications

Metric u.s.
Dimensions
Length 21.2 cm 8.35in
Width 29.0 cm 11.4in
Height (front to rear) 3.2cm 1.27 in
Weight (equipped with 1 DIMM, é-cell battery, WLAN 1.8 kg 3.97 lbs

module)

Input power

Operating voltage

185Vdc@3.5A-65W

Operating current 35A

Temperature

Operating 5°Cto 35°C 41°F to 95°F
Nonoperating -20°C to 60°C -4°F to 140°F
Relative humidity

Operating 10% to 90%

Nonoperating

5% to 95%

Maximum altitude (unpressurized)

Operating (14.7 to 10.1 psia)

-15 mto 3,048 m -50 ft to 10,000 ft

Nonoperating (14.7 to 4.4 psia) -15mto 12,192 m -50 ft to 40,000 ft
Shock
Operating 125 g, 2 ms, halfsine

Nonoperating

200 g, 2 ms, half-sine

Random vibration

Operating

0.75 g zeroo-peak, 10 Hz to 500 Hz, 0.25 oct/min sweep
rate

Nonoperating

1.50 g zero+o-peak, 10 Hz to 500 Hz, 0.5 oct/min sweep
rate

NOTE: Applicable product safety standards specify thermal limits for plastic surfaces. The computer operates well within this

range of temperatures.
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30.7-cm (12.1-in), WXGA display specifications

Metric uU.s.
Dimensions
Height 16.3 cm 6.4 in
Width 26.1 cm 10.3in
Diagonal 30.7 cm 12.1in
Surface treatment Anti-glare

Number of colors

Up to 16.8 million

Contrast ratio

400:1 (typical)

Brightness

200 nits (typical)

Pixel resolution

Pitch

0.204 mm

Format

1280 x 800

Configuration

RGB vertical stripe

Backlight LED
Character display 80 x 25
Total power consumption 4.0W

Viewing angle

+75° Horizontal, +75° Vertical (minimum)

+80° Horizontal, £80° Vertical (typical)

Hard drive specifications

128-GB* 160-GB* 250-GB* 320-GB*
Dimensions
Height 7.0 mm 7.0 mm 9.5 mm 9.5 mm
Width 70 mm 70 mm 70 mm 70 mm
Weight 75¢g 78g 115¢g 115¢g
Interface type SATA Gen 2 SATA Gen 2 SATA SATA
Transfer rate 100 MB/sec 100 MB/sec 300 MB/sec 300 MB/sec
Security ATA security ATA security ATA security ATA security

Seek times (typical read, including setting)

30.7-cm (12.1-in), WXGA display specifications
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128-GB* 160-GB* 250-GB* 320-GB*

Single track 3 ms 3 ms 1.5 ms 1.5 ms
Average 13 ms 13 ms 11 ms 11T ms
Maximum 24 ms 24 ms 22 ms 22 ms
Logical blocks 250,069,680 312,581,808 488,397,168 625,142,448
Disc rotational speed 7200 rpm 7200 rpm 7200 rpm 7200 rpm
Operating temperature 5°Cto 35°C 5°Cto 35°C 5°Cto 35°C 5°Cto 35°C

*1 GB = 1 billion bytes when referring to hard drive storage capacity. Actual accessible capacity is less. Actual drive
specifications may differ slightly.

NOTE: Certain restrictions and exclusions apply. Contact technical support for details.
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7 Backup and recovery

To protect your information, use Windows Backup and Restore to back up individual files and folders,
back up your entire hard drive (select models only), create system repair discs (select models only), or
create system restore points. In case of system failure, you can use the backup files to restore the
contents of your computer.

Windows Backup and Restore provides the following options:
e Creating a system repair disc (select models only)

e  Backing up individual files and folders

e Creating a system image (select models only)

e  Scheduling automatic backups (select models only)

e  Creating system restore points

e  Recovering individual files

e Restoring the computer to a previous state

e  Recovering information using recovery tools

E"%NOTE: For detailed instructions, perform a search for these topics in Help and Support.

E’%NOTE: In case of system instability, HP recommends that you print the recovery procedures and save
them for later use.

Backing up your information

Recovery after a system failure is as complete as your most current backup. You should create system
repair discs (select models only) and your initial backup immediately after software setup. As you add
new software and data files, you should continue to back up your system on a regular basis to maintain
a reasonably current backup. The system repair discs (select models only) are used to start up (boot) the
computer and repair the operating system in case of system instability or failure. Your initial and
subsequent backups allow you to restore your data and settings if a failure occurs.

You can back up your information to an optional external hard drive, a network drive, or discs.
Note the following when backing up:

e  Store personal files in the Documents library, and back it up regularly.

e  Back up templates that are stored in their associated programs.

e Save customized settings that appear in a window, toolbar, or menu bar by taking a screen shot
of your settings. The screen shot can be a time-saver if you have to reset your preferences.
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To create a screen shot:

1. Display the screen you want to save.

2. Copy the screen image:
To copy only the active window, press alt+fn+prt.
To copy the entire screen, press fn+prt sc.

3. Open a word-processing document, and then select Edit > Paste.
The screen image is added to the document.

4. Save the document.

e When backing up to discs, use any of the following types of discs (purchased separately): CD-R,
CD-RW, DVD+R, DVD+R DL, DVD-R, DVD-R DL, or DVD+RW. The discs you use will depend on the
type of optical drive installed in your computer.

E/%"NOTE: DVDs and DVDs with double-layer (DL) support store more information than CDs, so
using them for backup reduces the number of recovery discs required.

e  When backing up to discs, number each disc before inserting it into the optical drive of the
computer.

To create a backup using Backup and Restore, follow these steps:

@NOTE: Be sure that the computer is connected to AC power before you start the backup process.

@NOTE: The backup process may take over an hour, depending on file size and the speed of the
computer.

1. Select Start > All Programs > Maintenance > Backup and Restore.

2. Follow the on-screen instructions to set up your backup, create a system image (select models
only), or create a system repair disc (select models only).

E"jNOTE: Windows includes the User Account Control feature to improve the security of your
computer. You may be prompted for your permission or password for tasks such as installing
software, running utilities, or changing Windows settings. Refer to Help and Support for more
information.

Performing a recovery

In case of system failure or instability, the computer provides the following tools to recover your files:

e  Windows recovery tools: You can use Windows Backup and Restore to recover information you
have previously backed up. You can also use Windows Startup Repair to fix problems that might
prevent Windows from starting correctly.

e {11 recovery tools: You can use the f11 recovery tools to recover your original hard drive image.
The image includes the Windows operating system and software programs installed at the factory.
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E"jNOTE: If you are unable to boot (start up) your computer and you cannot use the system repair discs
you previously created (select models only), you must purchase a Windows 7 operating system DVD to
reboot the computer and repair the operating system. For additional information, refer to the “Using a
Windows 7 operating system DVD (purchased separately)” section in this guide.

Using the Windows recovery tools

To recover information you previously backed up, follow these steps:
1. Select Start > All Programs > Maintenance > Backup and Restore.

2. Follow the on-screen instructions to recover your system settings, your computer (select models
only), or your files.

E’%NOTE: Windows includes the User Account Control feature to improve the security of your computer.
You may be prompted for your permission or password for tasks such as installing software, running
utilities, or changing Windows settings. Refer to Help and Support for more information.

To recover your information using Startup Repair, follow these steps:

/\ CAUTION: Using Startup Repair completely erases hard drive contents and reformats the hard drive.
All files you have created and any software installed on the computer are permanently removed. When
reformatting is complete, the recovery process restores the operating system, as well as the drivers,
software, and utilities, from the backup used for recovery.

1. [If possible, back up all personal files.
2. If possible, check for the presence of the Windows partition and the HP Recovery partition.
To check for the Windows partition, select Start > Computer.

To check for the HP Recovery partition, select Start, right-click Computer, click Manage, and
then click Disk Management.

@NOTE: If the Windows partition and the HP Recovery partition are not listed, you must recover
your operating system and programs using the Windows 7 operating system DVD and the Driver
Recovery disc (both purchased separately). For additional information, refer to the “Using a
Windows 7 operating system DVD (purchased separately)” section in this guide.

3. If the Windows partition and the HP Recovery partition are listed, restart the computer, and then
press {8 before the Windows operating system loads.

4. On the Advanced Boot Options screen, use the arrow keys to highlight Repair your computer,
and then press enter.

5. Follow the on-screen instructions.

E/%"NOTE: For additional information on recovering information using the Windows tools, perform a
search for these topics in Help and Support.
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Using f11

/\ CAUTION: Using f11 completely erases hard drive contents and reformats the hard drive. Al files
you have created and any software installed on the computer are permanently removed. The {11
recovery tool reinstalls the operating system and HP programs and drivers that were installed at the
factory. Software not installed at the factory must be reinstalled.

To recover the original hard drive image using f11, follow these steps:
1. |If possible, back up all personal files.

2. |f possible, check for the presence of the HP Recovery partition: select Start, right-click
Computer, click Manage, and then click Disk Management.

E’/fNOTE: If the HP Recovery partition is not listed, you must recover your operating system and
programs using the Windows 7 operating system DVD and the Driver Recovery disc (both
purchased separately). For additional information, refer to the “Using a Windows 7 operating
system DVD (purchased separately)” section in this guide.

3. If the HP Recovery partition is listed, restart the computer, and then press esc while the “Press the
ESC key for Startup Menu” message is displayed at the bottom of the screen.

4. Press {11 to enter the HP Recovery menu.

Follow the on-screen instructions.

Using a Windows 7 operating system DVD (purchased separately)

If you are unable to boot (start up) your computer and you cannot use the system repair discs you
previously created (select models only), you must purchase a Windows 7 operating system DVD to
reboot the computer and repair the operating system. Make sure that your most recent backup (stored
on discs or on an external drive) is easily accessible. To order a Windows 7 operating system DVD, go
to http://www.hp.com/support, select your country or region, and then follow the on-screen
instructions. You can also order the DVD by calling technical support. For contact information, refer to
the Worldwide Telephone Numbers booklet included with the computer.

/\ CAUTION: Using a Windows 7 operating system DVD completely erases hard drive contents and
reformats the hard drive. All files you have created and any software installed on the computer are
permanently removed. When reformatting is complete, the recovery process helps you restore the
operating system, as well as drivers, software, and utilities.

To initiate recovery using a Windows 7 operating system DVD, follow these steps:

[/ NOTE:  This process takes several minutes.

1. |If possible, back up all personal files.

2. Restart the computer, and then insert the Windows 7 operating system DVD into the optical drive
before the Windows operating system loads.

When prompted, press any keyboard key.
4. Follow the on-screen instructions.

Click Next.
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6. Select Repair your computer.

7. Follow the on-screen instructions.

Performing a recovery 101



8 Power cord set requirements

The wide range input feature of the computer permits it to operate from any line voltage from 100 to

120 volts AC, or from 220 to 240 volts AC.

The 3-conductor power cord set included with the computer meets the requirements for use in the

country or region where the equipment is purchased.

Power cord sets for use in other countries and regions must meet the requirements of the country or

region where the computer is used.

Requirements for all countries and regions

The requirements listed below are applicable to all countries and regions:

e  The length of the power cord set must be at least 1.5 m (5.0 ft) and no more than 2.0 m (6.5 ).

e  All power cord sets must be approved by an acceptable accredited agency responsible for
evaluation in the country or region where the power cord set will be used.

e The power cord sets must have a minimum current capacity of 10 amps and a nominal voltage
rating of 125 or 250 V AC, as required by the power system of each country or region.

e The appliance coupler must meet the mechanical configuration of an EN 60 320/IEC 320
Standard Sheet C13 connector for mating with the appliance inlet on the back of the computer.

Requirements for specific countries and regions

Country/region Accredited agency Applicable note number
Australia EANSW 1
Austria OVE 1
Belgium CEBC 1
Canada CSA 2
Denmark DEMKO 1
Finland FIMKO 1
France UTE 1
Germany VDE 1
ltaly IMQ 1
Japan METI 3
The Netherlands KEMA 1
Norway NEMKO 1
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Country/region Accredited agency Applicable note number

The People's Republic of China CCC 5
South Korea EK 4
Sweden SEMKO 1
Switzerland SEV 1
Taiwan BSMI 4
The United Kingdom BSI 1
The United States uL 2

1. The flexible cord must be Type HO5VV-F, 3-conductor, 1.0-mm? conductor size. Power cord set fittings (appliance coupler
and wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it
will be used.

2. The flexible cord must be Type SPT-3 or equivalent, No. 18 AWG, 3-conductor. The wall plug must be a two-pole
grounding type with a NEMA 5-15P (15 A, 125 V) or NEMA 6-15P (15 A, 250 V) configuration.

3. The appliance coupler, flexible cord, and wall plug must bear a “T” mark and registration number in accordance with the
Japanese Dentori Law. The flexible cord must be Type VCT or VCTF, 3-conductor, 1.00-mm? conductor size. The wall plug
must be a two-pole grounding type with a Japanese Industrial Standard C8303 (7 A, 125 V) configuration.

4. The flexible cord must be Type RVV, 3-conductor, 0.75-mm? conductor size. Power cord set fittings (appliance coupler
and wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it
will be used.

5. The flexible cord must be Type VCTF, 3-conductor, 0.75-mm?2 conductor size. Power cord set fittings (appliance coupler
and wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it
will be used.
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9 Recycling

Battery

When a battery has reached the end of its useful life, do not dispose of the battery in general
household waste. Follow the local laws and regulations in your area for computer battery disposal.

Display

/\ WARNING! The backlight contains mercury. Caution must be exercised when removing and
handling the backlight to avoid damaging this component and causing exposure to the mercury.

/\ CAUTION: The procedures in this chapter can result in damage to display components. The only
components intended for recycling purposes are the liquid crystal display (LCD) panel and the
backlight. When you remove these components, handle them carefully.

E/?’NOTE: Materials Disposal. This HP product contains mercury in the backlight in the display assembly
that might require special handling at end-of-life. Disposal of mercury may be regulated because of
environmental considerations. For disposal or recycling information, contact your local authorities, or
see the Electronic Industries Alliance (EIA) Web site at http://www.eiai.org.

This section provides disassembly instructions for the display assembly. The display assembly must be
disassembled to gain access to the backlight (1) and the liquid crystal display (LCD) panel (2).

g -

@NOTE: The procedures provided in this chapter are general disassembly instructions. Specific details,
such as screw sizes, quantities, and locations, and component shapes and sizes, can vary from one
computer model to another.
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Perform the following steps:

1. Remove the (1) and screws (2) that secure the display bezel to the display assembly.

2. lift up and out on the left and right inside edges (1) and the top and bottom inside edges (2) of
the display bezel until the bezel disengages from the display assembly.

3. Remove the display bezel 3.
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4. Disconnect all display panel cables (1) from the display inverter and remove the inverter 2.

5. Remove all screws (1) that secure the display panel assembly to the display enclosure.

6. Remove the display panel assembly (2) from the display enclosure.

7. Turn the display panel assembly upside down.

8. Remove all screws that secure the display panel frame to the display panel.

9. Use a sharp-edged tool to cut the tape (1) that secures the sides of the display panel to the display
panel frame.
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10. Remove the display panel frame (2) from the display panel.

11. Remove the screws (1) that secure the backlight cover to the display panel.

12. Lift the top edge of the backlight cover (2) and swing it outward.

i
|
|
I E -

13. Remove the backlight cover.
14. Turn the display panel right-side up.
15. Remove the backlight cables (1) from the clip (2) in the display panel.

16. Turn the display panel upside down.

Display
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17. Remove the backlight frame from the display panel.

———— —

/\ WARNING! The backlight contains mercury. Exercise caution when removing and handling the
backlight to avoid damaging this component and causing exposure to the mercury.

18. Remove the backlight from the backlight frame.

19. Disconnect the display cable (1) from the LCD panel.
20. Remove the screws (2) that secure the LCD panel to the display rear panel.

21. Release the LCD panel (3) from the display rear panel.
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22. Release the tape (4) that secures the LCD panel to the display rear panel.

23. Remove the LCD panel.

24. Recycle the LCD panel and backlight.
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Symbols/Numerics
1394 port, identifying 14

A

Accessory battery connector
identifying 17

Accessory battery connector door
identitying 17

Ambient light sensor, identifying

15

AMT options 93
AMT setup prompt (Ctrl-P) 93
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support 93
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unconfigure AMT on next

boot 93
USB key provisioning support
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removal 76
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audio connector board
spare part number 22
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contents 25
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caps lock light, identifying 7
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Security menu 88
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drive light 7
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Drivelock, automatic 88
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esc button
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F
f11 recovery 100
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removal 82
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graphics, product description 1
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specifications 95
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hard drive recovery 100
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K
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product description 3
removal 55
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L
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Setup 90
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removal 73

spare part number 73
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spare part number 22
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removal 70
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packing guidelines 38
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spare part number
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pointing device, product
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pointing stick 6
pointing stick buttons 6

port options

92
1394 port 92
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USB port 92
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1394 14

power connector, identifying
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product description

USB 12
USB charging
USB chargingt
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spare part numbers
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description 3
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processor, product description

45

removal
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Ethernet 2

external media cards

graphics 1
hard drives 2
keyboard 3
memory module
microphone 2

1

modem module 2
operating system 4
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restore the factory seftings 87

restoring the hard drive 100
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spare part number 21, 65
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Attachment) devices 90
AHCI (Advanced Host Controller
Interface) 90
IDE (Integrated Drive
Electronics) 90
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removal 58
spare part numbers 58
security cable slot, identifying
Security menu 88
always prompt for HP SpareKey
enrollment 88
Automatic Drivelock 88
change password 88
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Disk Sanitizer 88
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fingerprint reader reset 88
HP Sparekey 88
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service tag 40

set security level 93
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File menu 87

navigating and selecting 85

restoring factory seftings 86
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System Configuration menu 90
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SIM, removal 47
slots
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smart card reader

identifying 12

removal 78

spare part number 78
solid-state drive, spare part
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removal 74

spare part number 21, 74
speakers, identifying 11
specifications

computer 94

display 95

hard drive 95
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removal 80

spare part number 21

spare part numbers 80
system board shield

removal 69

spare part number 21

spare part numbers 69
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system date and time 87
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system fan 90
system IDs 89
system information 87

T
thermal material, replacement 84
tools required 35
top cover

removal 60

spare part number 21, 60
Touch screen

identifying 15
TouchPad

buttons 6
TouchPad board

removal 64

spare part number 64
TouchPad light, identitying 7
TouchPad, identifying 6
TPM Embedded Security 88
transporting guidelines 38
TXT (IntelTrusted Execution

Technology) 91

U

Unified Extensible Firmware
Interface (UEFI) mode 90

USB charging port, identifying
14

USB legacy support 85, 90

USB ports, identifying 12

user management 88

\"

vents, identifying 13, 17
Virtualization Technology 91
volume down button, identifying 9
volume down light 7

volume mute button, identifying 9
volume up button, identifying 9
volume up light 7

w
webcam 14

product description 2
webcam light

identifying 11
webcam light, identifying 14
webcam, identifying 14
Windows 7 operating system

DVD 100

Windows applications key,
identifying 10
Windows logo key, identifying
10
wireless antennas
disconnecting 52
wireless antennas, disconnecting
53
wireless antennas, identifying 14
Wireless light
identifying 13
Wireless switch
identifying 13
wireless, product description 2
WILAN antennas, identifying 14
WILAN module
removal 50
spare part number 50
spare part numbers 23
workstation guidelines 38
WWAN antennas, identifying 14
WWAN module
removal 53
spare part number 53
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